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Zusammenfassung

Die Reproduzierbarkeit von radiologisch-anatomischen Landmarks zur

Determination der Gelenkspaltgrenzen des Articulatio temporomandibularis

Christian Fleuter

Zur Evaluierung so komplexer Strukturen wie dem Kiefergelenk ist eine dreidimensionale Betrachtung unumgänglich.

Es soll eine Methode entwickelt werden, mit der sich anhand von computertomographischen Aufnahmen das

Volumen des Gelenkspalts bestimmen lässt. Hierzu wurden landmarks zur Grenzbestimmung des Gelenks definiert.

Zur Beurteilung der Prozessqualität wurden die landmarks auf ihre interindividuelle Reproduzierbarkeit untersucht.

Um eine Vergleichsmöglichkeit zu haben, wurden neben den landmarks im Bereich der Kiefergelenke bereits in der

Literatur etablierte landmarks im Bereich der Orbita mit in die Studie einbezogen. Fünf Untersucher haben an

identischen digitalen Kopien der ausgewählten achtzehn originalen CT-Datensätze jeweils die neunzehn landmarks

identifiziert. Aus der Euklidischen Distanz zwischen zwei gleichen von den verschiedenen Untersuchern gesetzten

landmarks wurde ein Fehlerradius für jeden untersuchten landmark erstellt.

Der interindividuelle Fehlerradius für alle neunzehn untersuchten landmarks lag durchschnittlich bei 

€ 

R LM  = 2,04 mm

± 2,20 mm. Die für die Evaluation des Kiefergelenks definierten landmarks wiesen mit einem durchschnittlichen

Fehlerradius von 

€ 

R TMJ = 1,89 mm ± 2,07 mm einen überdurchschnittlich guten Wert auf. Im Vergleich mit den

orbitalen landmarks mit einem Fehlerradius von 

€ 

R Orbital = 2,27 mm ± 1,87 mm besitzen die landmarks im Bereich

des Kiefergelenks eine bessere Reproduzierbarkeit. Sie ermöglichen eine reliable Definition der kaudalen

Grenzebene des Kiefergelenks zur volumetrischen Erfassung des Gelenksspaltes.

Für die graphische Ausrichtung der Kiefergelenke in Bezug auf diese Grenzebene wurde für die verwendete

Software ImageJ [58] ein Plugin programmiert. Dieses Plugin errechnet mit Hilfe der Koordinaten der

entsprechenden landmarks die Rotationswinkel und Rotationsrichtung und führt die entsprechenden Rotationen aus.

Auf diese Weise werden die Kiefergelenke mit großer Präzision entsprechend ihrer Grenzebene im

dreidimensionalen Raum ausgerichtet.
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1 Einleitung

1.1 Das Kiefergelenk

Das Kiefergelenk (Articulatio temporomandibularis) stellt die bewegliche

Verbindung zwischen Unterkiefer (Mandibula) und der Schädelbasis dar. Die

Erforschung der Funktion des Kiefergelenks mit seinen sechs Freiheitsgraden

und den so ermöglichten komplexen Bewegungsabläufen stellt eine große

Herausforderung für Wissenschaftler und Kliniker dar [72].

1.1.1 Die Morphologie des Kiefergelenks

Im Kiefergelenk artikulieren das Caput mandibulae des Processus condylaris

mit der Fossa mandibularis und dem Tuberculum articulare des Os temporalis.

Es stellt die bewegliche Verbindung des Unterkiefers mit der Schädelbasis dar.

Das Caput mandibulae hat die Form einer Walze mit einer Breite von ca. 20

mm und einer Höhe von ca. 7 mm. Die beiden Gelenkköpfe sind leicht schräg

angeordnet, so dass sich die verlängerten Achsen beider Kondylen – horizontal

betrachtet – am vorderen Rand des Foramen magnum in einem stumpfen

Winkel von etwa 150° bis 175° schneiden. Die Gelenkköpfe sind mit

Faserknorpel überzogen, wodurch der Verschleiß vermindert wird.

Die Gelenkfläche, die Facies articularis, besteht aus der Fossa mandibularis

und dem Tuberculum articulare auf der exocranialen Seite der Schädelbasis.

Die Fossa mandibularis an der Pars squamosa des Os temporalis wird ventral

und lateral durch die Wurzeln des Processus zygomaticus begrenzt. Nach

medial findet sich als Grenze die Glaser´sche Spalte, die Fissura petro-

tympanica, nach dorsal liegt der Meatus acusticus externus. Das Dach der

Gelenkgrube wird durch eine dünne Knochenlamelle gebildet, die die Fossa von

der mittleren Schädelgrube trennt. Die Gelenkgrube ist etwa doppelt so groß
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wie das Caput mandibulae, so dass ein großer Bewegungsfreiraum für den

Kondylus gegeben ist. Auch die Gelenkfläche ist von Faserknorpel überzogen.

Der Discus articularis ist ovoid gestaltet und gleicht die Inkongruenz zwischen

Gelenkköpfchen und Gelenkpfanne aus. Der Diskus kann in fünf Anteile

aufgeteilt werden. Anterior inseriert die Sehnen des oberen Bauches des M.

pterygoideus lateralis. Es folgt ein dickerer faserknorpeliger Anteil. Die dünne

intermediäre Zone besteht aus straffem Bindegewebe. Es folgt wieder ein

dickerer faserknorpeliger Anteil. Als letzter Teil schließt sich ein elastisches

Band, das Ligamentum discotemporale an, das den Discus in seiner richtigen

Lage zwischen dem Gelenkköpfchen und der Gelenkpfanne hält.

Abbildung 1.1: Schnittbild Kiefergelenk von lateral (aus [57])

Die Gelenkkapsel entspringt am Rande der Fossa mandibularis, schließt das

Tuberculum articulare mit ein und setzt unterhalb des Caput mandibulae am

Unterkieferhals an. Sie ist so weit, dass das Gelenkköpfchen nach ventral auf

das Tuberculum articulare versetzt werden kann, ohne dass sie einreißt. Die

Kapsel wird durch mehrere Bänder verstärkt. Die Kapsel ist ringsherum fest mit

dem Discus articularis verwachsen und teilt das Kiefergelenk so in eine obere

discotemporale und eine untere discomandibuläre Kammer. Die gleichnamigen
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Gelenkspalten sind mit Gelenkflüssigkeit, der Synovia, gefüllt. Die Synovia wird

von der inneren Schicht der Gelenkkapsel, Stratum synoviale, gebildet. Auf

diese Weise wird die Nutrition der beteiligten bradytropen Gewebe

gewährleistet, die Gleitfähigkeit erhöht und für den Abtransport abgeriebener

Knorpelteilchen gesorgt [6, 24, 57, 66].

1.1.2 Funktion des Kiefergelenks

Das Kiefergelenk ist ein Dreh- Gleitgelenk. Es verfügt über sechs

Freiheitsgrade. Man unterscheidet Abduktion bzw. Adduktion (Öffnungs- und

Schließbewegung), Protrusion bzw. Retrusion (Vorschub- und

Rückschubbewegung), sowie Laterotrusion bzw. Mediotrusion

(Seitwärtsbewegung).

Abbildung 1.2: Schnittbild Kiefergelenk von lateral bei Mundöffnung (aus [57])
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Die Adduktoren sind der M. masseter und der M. pterygoideus medialis. Zur

Abduktion dient die infra- und suprahyoidale Muskulatur, sowie der M.

pterygoideus lateralis. Bei einseitiger Kontraktion des M. pterygoideus lateralis

kommt es zur Laterotrusion, bei beidseitiger Kontraktion zur Protrusion. Die

mittleren und hinteren Faseranteile das M. temporalis fungieren als Retraktoren.

Begrenzt wird die Beweglichkeit durch die Muskulatur und den Bänderapparat.

Da die Mandibula ein unpaariger Knochen ist, werden immer beide Kondylen

gegenüber der Schädelbasis bewegt.

Bei der Öffnungs- und Schließbewegung handelt es sich um eine kombinierte

Scharnier- Schiebebewegung. Die Öffnung beginnt mit einer reinen

Rotationsbewegung. Im weitern schließt sich eine Gleitbewegung an. Unter

dem Einfluss des M. pterygoideus lateralis rutscht der Diskus auf das

Tuberculum articulare. Gleichzeitig bewegt sich der Kieferwinkel nach dorsal.

Diese Drehung des Unterkieferastes findet um eine Achse statt, die beidseits

durch das Foramen mandibulae verläuft, so dass der dort in den Unterkiefer

eintretende Nervus alveolaris inferior nicht irritiert wird. Im physiologischen Falle

ist die Mundöffnung bis zu einer Schneidekantendistanz von 40-50 mm möglich.

Die Pro- und Retrusion sind reine Gleitbewegungen, die im discotemporalen

Gelenk unter Führung der Zahnreihen stattfinden. So haben Zustand, Form und

Stellung der Zähne und die Form der Gelenkfläche, die horizontale

Kondylenbahn, wesentlichen Einfluss auf diese Funktion des Kiefergelenks.

Die Laterotrusion bzw. Mediotrusion findet ebenfalls unter Führung der

Zahnreihen statt. Durch einseitige Kontraktion des M. pterygoideus lateralis

gleitet der Discus und der Kondylus der Mediotrusionsseite nach anterior medial

kaudal auf das Tuberculum articulare. Auf der kontralateralen Seite, der

Laterotrusionsseite, rotiert der Kondylus um eine senkrechte Achse.

Der Vorgang des Kauens ist ein komplexer Bewegungsablauf, bei dem sowohl

Ab- und Adduktion, als auch Medio- und Laterotrusion zusammenspielen. Der

Unterkiefer wird in der so genannten Kauschleife bewegt, so dass die mit der zu

zerkleinernden Speise beladenen Seitenzähne beim Zubiss exakt im Verlauf

ihrer Achsen belastet werden. So lässt sich effizient bei minimalem
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Kraftaufwand ein maximaler Nutzen erzielen und die Krafteinwirkung auf das

Kiefergelenk reduzieren [6, 24, 57, 66].

1.1.3 Kieferrelation

Die physiologische Lagebeziehung des Kondylus mit seinen sechs

Freiheitsgraden [72] zur Gelenkgrube wird in der Literatur kontrovers diskutiert.

Als Name für die ideale Position des Kondylus in der Fossa articularis etablierte

sich der  Begriff „Centric Relation“. Die Definition dieser Position wechselte im

Laufe der Zeit mehrmals. 1956 bezeichnete das Glossary of Prosthodontic

terms der Academy of Denture Prosthetic die „most retruded position“ als die

physiologische [26]. 1987 wurde die Definition von „most posterior superior“ in

„most superior anterior“ geändert [27]. Die bis heute gültige Definition stammt

aus dem Jahre 1994. „Die cranio-ventrale, nicht seitenverschobene Position

beider Kondylen bei physiologischer Kondylus-Diskus-Relation und

physiologischer Belastung der beteiligten Gewebe“ [28].

1952 sagte Posselt, die Lage der Kondylen im Gelenk sei durch Bänder

beeinflusst [56]. Boucher et Jacoby folgerten 1968 nach gezieltem Einsatz von

Muskelrelaxantien, dass die Position der Kondylen in der Fossa articularis

muskulär bestimmt und nicht unveränderlich sei [8]. Ein neuromuskulärer

Einfluss auf die Kondylen wurde 1973 von Calagna, Silverman et Garfinkel

nachgewiesen [12].

Helkimo, Ingervall et Carlsson zeigten 1971 einen Zusammenhang zwischen

Körper- bzw. Kopfhaltung des Patienten und der Position der Mandibula auf

[30]. Piehslinger beschrieb 1993 die „Centric Relation“ nicht als Punkt, sondern

als „area of reference position“ mit einem Durchmesser von 0,2 mm [55].

In der Literatur sind mehr als 70 Verfahren zur Bestimmung der Kondylus-

Fossa-Relation beschrieben. Es finden sich viele logische Hypothesen,

allerdings nur wenige klinische Fakten. Es stellt sich die Frage, ob bei der

Evaluierung dieses komplexen Gelenkes eine Reduzierung auf zwei

Dimensionen, wie es die herkömmliche Radiologie mit sich bringt ausreichend
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ist, oder ob viel mehr eine dreidimensionale Darstellung durch beispielsweise

die Computertomographie notwendig ist.
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1.2 Bildgebende Verfahren zur Darstellung des Kiefergelenks

Im Laufe der Jahre wurden verschiedenste Techniken zur bildlichen Darstellung

des Kiefergelenks entwickelt. Die Aufnahmen des Kiefergelenks ohne störende

Überlagerungen durch die umgebenden Strukturen insbesondere durch das

Felsenbein und den Jochbogen anzufertigen, stellt hierbei eine grundlegende

Schwierigkeit dar. Das Ergebnis der Aufnahmen ist daher erheblich vom

Strahlengang abhängig. Zum anderen wird in der Regel ein komplexes

dreidimensionales System auf eine zweidimensionale Fläche projiziert. Hier

bietet die Computertomographie den Vorteil mit Hilfe entsprechender Software

dreidimensionale Bilder erstellen zu können.

Gemeinsam ist den verschiedenen röntgenologischen Verfahren die Nutzung

der erstmals von dem Physiker Wilhelm Conrad Röntgen (Abbildung 1.3) im

Jahre 1895 beschriebene Röntgenstrahlung.

1.2.1 Die Röntgenstrahlung

Durch die epochale Entdeckung des „Unsichtbaren Lichtes“ 1895 durch

Wilhelm Conrad Röntgen wurde der unblutigen Erforschung des lebenden

Körpers und der menschlichen Anatomie ungeahnte Möglichkeiten eröffnet.

Darüber hinaus stellten die X-Strahlen, wie Röntgen seine Entdeckung

zunächst nannte, ein innovatives non-invasives diagnostisches Hilfsmittel dar

[52, 64]. Röntgen konnte schon nach seinen ersten Experimenten mit der

Röntgenstrahlung alle ihre wesentlichen Eigenschaften beschreiben [75]. Sie

konnte bestimmte Materialien durchdringen, wobei die Absorptionsfähigkeit der

durchstrahlten Objekte eine entscheidende Rolle spielte. Die Intensität der

Strahlung nahm mit dem Quadrat des Abstandes zur Strahlungsquelle ab. Die

Strahlung breitete sich gradlinig aus. Beim Auftreffen von Strahlung auf

bestimmte Materialien wurde Fluoreszenz ausgelöst und photographische

Schichten ließen sich schwärzen. Bereits am 22.12.1895 fertigte Röntgen die
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weltbekannt gewordene Aufnahme von der Hand seiner Frau an

(Abbildung 1.3).

Abbildung 1.3: Wilhelm Conrad Röntgen und die am 22.12.1895 angefertigte Aufnahme

von der Hand seiner Frau

Insgesamt beschäftigten sich nur drei seiner sechzig Veröffentlichungen mit der

X-Strahlung. 1901 erhielt Röntgen den zum ersten Mal verliehenen Nobel-Preis

für Physik.

Röntgenstrahlung wird in einer Röntgenröhre erzeugt. Die Röntgenröhre

besteht aus einem bleiummantelten Glaszylinder, in dem ein Hochvakuum

vorliegt. Innerhalb des Vakuums befinden sich eine Glühkatode und eine

Bremsanode, zwischen denen eine Hochspannung angelegt wird. Ist die

Glühkatode aufgeheizt, werden Elektronen frei, die im elektrischen Feld

beschleunigen und ohne Wechselwirkungen mit Luftmolekülen in dem

Hochvakuum mit hoher Geschwindigkeit auf die Anode treffen. Die Elektronen

werden abgebremst. Hierbei entsteht ein Bremsspektrum, das heißt es entsteht

Strahlung in allen Wellenlängenbereichen, unter anderem auch

Röntgenstrahlung. Die Strahlung tritt über ein Austrittsfenster aus der

Röntgenröhre aus. Je höher die Spannung zwischen Kathode und Anode

gewählt wird, desto größer ist die Beschleunigung der Elektronen und desto

energiereicher ist die entstehende Strahlung. Energiereiche, so genannte

„harte“ Strahlung hat eine höhere Durchdringungsfähigkeit als „weiche“

Strahlung [52, 64, 75].
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1.2.2 Übersicht über verschiedene Verfahren

• Kiefergelenkaufnahme nach Clementschitsch

Die Röntgenaufnahme nach Clementschitsch ist die Standardaufnahme

zur Diagnostik von Condylusfrakturen. Durch den Strahlengang, der in

der Median-Sagittal-Ebene vom Nacken zur Nasenwurzel verläuft, erhält

man eine kaudal-exzentrische Projektion.

• Transcraniale schräglaterale Röntgenaufnahme

Diese Aufnahmetechnik basiert auf einer cranial- und

dorsalexzentrischen Ausrichtung des Zentralstrahls. So trifft dieser nach

Möglichkeit axial auf das filmnahe Kiefergelenksköpfchen. So lässt sich

der Condylus weitgehend überlagerungs- und verzerrungsfrei darstellen

[69]. Vorreiter dieser Aufnahmetechnik war Schüller, der diese Technik

bereits 1905 beschrieb [68]. Bei der transcranialen Röntgenaufnahme

nach Parma trifft der Zentralstrahl bei weit geöffnetem Mund direkt von

lateral auf den Condylus. Hierdurch kann die Position des Condylus in

der Fossa verzerrungsfreier dargestellt werden.

• Tomographie (Schichtaufnahmen)

Die konventionelle Tomographie erstellt von einer bestimmten Ebene des

zu untersuchenden Körpers eine scharfe Abbildung, wobei diese von den

verwischt dargestellten Strukturen, die vor oder hinter der gewünschten

Schicht liegen, überlagert wird. Die Verwischung wird durch einen

abgestimmten Bewegungsablauf von Röntgenröhre und Röntgenfilm

erreicht.

Petrilli et Gurley fertigten 1939 die ersten Kiefergelenk-

Schichtaufnahmen an [53]. Der Vorteil gegenüber Panorama-
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Schichtaufnahmen liegt nach Ong et Franklin in der besseren

Diagnosemöglichkeit degenerativer Veränderungen [50]. Insbesondere

aufgrund der hohen Strahlenbelastung wird das Verfahren nur noch in

sehr spezifischen Fällen angewendet.

• Ortho-Pan-Tomogramm (Panoramaschichtaufnahme)

Das OPG bietet eine Übersicht über das gesamte Kauorgan und stellt die

Standardröntgenaufnahme in der zahnärztlichen Praxis dar. Durch einen

definierten Bewegungsablauf von Röntgenröhre und Röntgenfilm um den

Kopf des Patienten können die Strukturen, die in der Ebene des

Alveolarkamms liegen scharf dargestellt werden. Das OPG enthält viele

Verzeichnungen und Unschärfen und ist eher als Übersichtsaufnahme

anzusehen. Die Strahlenbelastung ist sehr gering. Auch die

Kiefergelenke werden dargestellt, wenn sie auch außerhalb der

beschriebenen Schichtebene liegen. Das Funktions-OPG zeichnet

ausschließlich den Bereich der Kiefergelenke auf und kann bei

geöffnetem und geschlossenem Mund durchgeführt werden [69]. Im

Zusammenhang mit arthropathischen Beschwerden ist es geeignet um

Hinweise auf degenerative Veränderungen und Luxationen zu erkennen.

Jedoch bleibt auch hier zu berücksichtigen, dass die Abbildung relativ

unscharf ist.

• MRT (Magnet-Resonanz-Tomographie)

Die Magnet-Resonanz-Tomographie ist ein Verfahren, dass ohne

schädliche Röntgenstrahlung und damit ohne jedes durch Strahlung

verursacht Risiko auskommt. Das technische Prinzip der

Magnetresonanz wurde 1946 von Bloch und Purcell unabhängig

voneinander entdeckt und bald in  Physik und Chemie angewandt. 1952

erhielten die beiden Wissenschaftler den Nobelpreis für ihre Entdeckung.

Die Weiterentwicklung zu einer Technik in der  Medizin, mit Hilfe derer
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Bilder des menschlichen Körpers erzeugt werden können, wurde im

wesentlichen durch Lauterbur und Mansfield im Jahr 1973

vorangetrieben. Dafür bekamen sie 2003 den Nobelpreis für Medizin.

Praktisch verfügbar ist das Verfahren seit 1984. In einem starken

Magnetfeld werden Protonen in eine bestimmte Richtung ausgependelt.

Nach Änderung des Energiefeldes kehren die Protonen in ihre

ursprüngliche Lage zurück und geben die hierbei absorbierte Energie

wieder ab. Diese Energie ist messbar und ermöglicht durch komplexe

mathematische Zusammenhänge die Errechnung einer graphischen

Darstellung. Mit dem MRT können auch Weichteile dargestellt werden,

so dass es im Bezug auf das Kiefergelenk auch die Beurteilung des

Discus articularis und dessen Position zu Condylus und Fossa ermöglicht

[69]. Als deutlicher Nachteil müssen die sehr hohen Kosten aufgeführt

werden.

• Arthroskopie

Hierbei wird bei einem kleinen chirurgischen Eingriff eine endoskopische

Kamera in den oberen Gelenkspalt eingebracht, die ihre Aufnahmen auf

einen Monitor überträgt. Im Rahmen dieses Eingriffs ist eine Spülung des

Gelenkspaltes möglich.

• Sonographie

Ein Schallkopf sendet Ultraschallwellen in den zu untersuchenden

Körper. Je nach Gewebe, auf welches die Schallwellen treffen, werden

sie in unterschiedlichem Maße absorbiert oder reflektiert. Ein Empfänger

wandelt die reflektierten Schallwellen in elektrische Impulse um die

bildlich wiedergegeben werden können. Die Untersuchung des

Kiefergelenks mit Ultraschall spielt aufgrund der starken Überlagerung

durch knöcherne Strukturen eher eine untergeordnete Rolle. Ein Vorteil
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dieser Technik ist die Möglichkeit, Bewegungen des Gelenkköpfchens

darstellen zu können.

• Szintigraphie

Die Szintigraphie ist eine nuklearmedizinisch Untersuchung, bei der

Radionuklide in den Körper eingebracht werden. Diese reichern sich im

zu untersuchenden Organ oder Gewebe an. Die kurzlebigen

Radionuklide senden Gamma-Strahlung aus, wenn sie in ihren stabilen

Grundzustand übergehen. Die Aktivitätsverteilung, also die räumliche

Verteilungsdichte der aus dem  Körper austretenden Gamma-Strahlung

kann als Bild im Szintigramm dargestellt  werden. Durch die Szintigraphie

können erhöhte Stoffwechselaktivitäten z. B. entzündliche Prozesse oder

erhöhte knöcherne Umbauvorgänge diagnostiziert werden.

1.2.3 Die Computertomographie

Bei der Computertomographie handelt es sich um ein spezielles

Röntgenverfahren, das Querschnittsbilder verschiedener Körperabschnitte

anfertigt. Das Verfahren wurde 1972 von dem amerikanischen Physiker A.M.

Cormack und dem britischen Ingenieur G. N. Hounsfield entwickelt, die für ihre

Entwicklung 1979 den Nobelpreis für Medizin erhielten.

Bei einer herkömmlichen Röntgenaufnahme erhält man eine zweidimensionale

Projektion eines dreidimensionalen Körpers, das heißt eine

Summationsabbildung, bei der sich alle im Strahlengang befindlichen Gewebe

überlagern.

Die konventionelle Tomographie erstellt von einer bestimmten Ebene des zu

untersuchenden Körpers eine scharfe Abbildung, wobei diese von den

verwischt dargestellten Strukturen, die vor oder hinter der gewünschten Schicht

liegen, überlagert wird.
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Die Computertomographie ist im Vergleich dazu in der Lage, die Bildinformation

des abzubildenden Querschnitts ohne verwirrende Bildüberlagerungen

darzustellen.

Abbildung 1.4: Computertomograph der Firma Siemens

Bei der Computertomographie dreht sich ein mechanisch verbundenes

Röntgenröhren-Detektor-System kreisförmig um die Längsachse des Patienten.

Ein bleistiftdünnes Strahlenbündel durchdringt die zu untersuchende

Körperschicht. Der Detektor ist 100mal sensitiver als ein normaler Röntgenfilm.

Er misst die auf der anderen Seite der Körperschicht austretende

Strahlungsintensität und setzt diese in elektrische Signale um, deren Intensität

von der Menge der eintreffenden Strahlen, die also nicht von dazwischen

liegenden Geweben absorbiert wurden, abhängt. Diese Signale werden in

Bildpunkte unterschiedlicher Helligkeit umgerechnet. Das so produzierte Bild

entspricht dem eines Röntgenbildes von dem entsprechenden

Körperquerschnitt eines lebenden Patienten.

Die Leistung eines Computer Tomographen hängt von verschiedenen Faktoren

ab. Wesentliche Bedeutung kommen dem Detektor, dem Rekonstruktions-

Algorhitmus, der Strahlenquelle, der verwendeten Strahlendosis, der Computer-

und Displayelektronik und der Software für die Nachbearbeitung zu.

In den letzten Jahrzehnten wurde die Computer Tomographie kontinuierlich

durch kürzere Aufnahmezeit und höhere Bildqualität verbessert. Eine

entscheidende Weiterentwicklung stellt die in den 1990er Jahren eingeführte
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Spiral-Computertomographie dar [81]. Hierbei handelt es sich um eine

kontinuierliche Aufnahme, bei der der Patient mit einer konstanten

Geschwindigkeit durch die Öffnung des Computertomographen (gantry)

gefahren wird und die Einheit aus Röntgenröhre und Detektor kontinuierlich um

den Patienten kreist. Die Untersuchung kann somit zeitlich deutlich verkürzt

werden, so dass die Gefahr von Bewegungsartefakten, beispielsweise durch

Atmungsbewegungen, stark minimiert werden kann. Im Gegensatz zur

konventionellen Computertomographie, bei der während der Messung

sequentiell Schicht um Schicht  gemessen wird, erfolgt bei der Spiral-

Computertomographie die schichtweise Bildrekonstruktion aus dem primär

gemessenen spiralförmigen Rohdatensatz durch Messwertinterpolation mit

variablen Schichtabständen.

1998 wurde die Multi-Slice- Computertomographie vorgestellt. Hierbei werden

nach dem gleichen Prinzip wie bei der Spiral-Computertomographie gleichzeitig

zwei transaxiale Schichten durch die Verwendung zweier paralleler

Detektorbänke aufgenommen, was eine weitere Reduzierung der Aufnahmezeit

und somit eine Verringerung der Bewegungsartefakte ermöglicht. Es kann eine

hohe Anzahl an Schichten aufgezeichnet werden bei besserer Nutzung der

exponierten Strahlung [81].

2001 kamen Cone-Beam-Scanner auf den Markt. Diese können aufgrund

parallel geschalteter Sensorfelder mit einem einzigen Umlauf um den Patienten

– ähnlich wie bei einem Orthopantomograph – ein komplettes Kopfvolumen

aufzeichnen. Durch ihre kompakte Bauweise und ihren erschwinglichen Preis

sind sie auch für den Einsatz in der zahnärztlichen oder oralchirurgischen

Praxis geeignet. Bei voranschreitender Dosisreduktion stellt diese Technik

vielleicht einmal eine ernst zunehmende Alternative zum OPG dar [44, 81].

Die digitale Form eines CT-Datensatzes ermöglicht quantitative Angaben in

Form von Dichte-, Distanz-, Winkel- und Flächenmessungen. Es können auch

Bilder errechnet werden, die in einer anderen als der primär aufgenommenen

Schichtebene liegen, wobei aber ein Verlust an räumlicher Auflösung

unvermeidlich ist [9, 25, 48, 75].
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Lineare oder volumetrische Vermessungen am Bildschirm sind zuverlässig

verwendbar, da die Messwerte mit den anatomischen Abmessungen

übereinstimmen [11, 59, 63]. Besonders im Bereich der Mandibula besteht kein

signifikanter Unterschied zwischen Vermessungen einer CT-Aufnahme und

makroskopischen Messungen. Strecken lassen sich zuverlässiger vermessen

als Winkel [18].

Neben der zweidimensionalen Schichtbilddarstellung ist auch eine

dreidimensionale Oberflächenrekonstruktion möglich. Dies half, die

diagnostischen Möglichkeiten weiter zu verbessern und zielgerichtete

präoperative Therapieplanungen vorzunehmen [3].

1.2.3.1 Computertomographische Darstellung und Diagnostik des

Kiefergelenks

Eine Reduzierung auf zwei Dimensionen, wie es die herkömmliche Radiologie

mit sich bringt, ist bei der Untersuchung des Kiefergelenkes nicht immer

ausreichend. Vielmehr ist häufig eine dreidimensionale Darstellung notwendig.

Panorama-Aufnahmen bilden nur wenige Details ab. Aufgrund von

Überlagerungen durch kontralaterale Strukturen ist nur eine grobe Beurteilung

von Kondylus-Abnormalitäten möglich. Tomographie-Aufnahmen vermeiden

zwar das Problem der Überlagerung, es besteht jedoch die Gefahr, dass durch

eine unglückliche Wahl der Schichtebene falsch-negative Diagnosen entstehen,

so dass häufig mehrere Aufnahmen nötig sind. Außerdem wird im Gegensatz

zur CT nur ein geringer Prozentsatz des durchstrahlten Gewebes auch

abgebildet [63].

Durch die Einführung der High-Resolution Computertomographie in den 1980er

Jahren mit Schichtdicken von 2 mm wurde die Computertomographie

interessant für die craniofaciale Anwendung [81]. Aufgrund des hohen

Auflösungsvermögens ist die Computertomographie ein exzellentes Verfahren

zur Beurteilung knöcherner Gelenkstrukturen. Sie bietet durch detaillierte

Aufnahmen essentielle Informationen, die auf herkömmlichen Röntgenbildern
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nicht zu sehen sind und ist damit herkömmlichen Röntgenaufnahmen und der

konventionellen Tomographie im Hinblick auf ihr diagnostisches Potential

überlegen [21, 74]. Aus diesem Grunde wird die Computertomographie

zunehmend auch zur Untersuchung primärer und sekundärer

Kiefergelenkserkrankungen herangezogen. Sie ist beispielsweise indiziert zur

Beurteilung von Knochenabnormalitäten, Frakturen, Dislokationen, Arthritiden,

Sklerosierungen, Ankylosen, Hyperplasien und Neoplasien. Zahnärztliche

Chirurgen können wichtige Strukturen wie den Canalis mandibulae in ihrer

Lagebeziehung zu den umgebenden anatomischen Beschaffenheiten aus der

Sicht der dritten Dimension beurteilen.

Der Diskus ist mit der Computertomographie grundsätzlich darstellbar. Durch

die Verwendung spezieller Weichteilfilter besteht die Möglichkeit, neben den

knöchernen Begebenheiten auch weichgewebige Strukturen abzubilden. So

eignet sich die Computertomographie durchaus zur Diagnostik von

Diskusabnormalitäten und Diskusverlagerungen. Die Abbildung von

Weichgeweben in der Computertomographie ist allerdings als nicht besonders

zuverlässig einzuschätzen. Das Verfahren der Wahl zur Beurteilung der

Diskusform und –position ist heute die Magnetresonanztomographie, die besser

reproduzierbare und präzisere Aufnahmen von so fi l igranen

Weichgewebsstrukturen wie dem Diskus des Kiefergelenks ermöglicht [11, 17,

21, 74, 80].

Da die Computertomographie mit einer relativ hoher Strahlenbelastung und

vergleichsweise hohen Kosten verbunden ist, sollte die Indikation für die

Computertomographie nicht leichtfertig gestellt werden [9]. Sie ist nicht bei

Routineuntersuchungen indiziert, sondern als weiteres diagnostisches Mittel,

wenn die konventionellen radiologischen Untersuchungen trotz bestehender

Beschwerden keinen Hinweis auf eine pathologische Veränderung geben [17,

21].

Durch spezielle Rechenroutinen ist es möglich, eine dreidimensionale

Darstellung der Oberflächen der abgebildeten Strukturen zu erhalten. Den

Oberflächenpixeln werden hierbei in Abhängigkeit von ihrer Entfernung und

Lage zum Betrachter verschiedene Graustufen zugeteilt. Dieses
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dreidimensionale Bild kann in alle Richtungen rotiert werden, so dass eine

Untersuchung des Kiefergelenks aus jedem beliebigen Winkel ermöglicht wird.

Das Kiefergelenk kann mit diesem Verfahren in seine Einzelteile zerlegt

werden, so dass auch bislang verborgene Oberflächen, wie zum Beispiel die

Fossa articularis beurteilt werden können. Es werden filigrane anatomische

Details abgebildet, wie beispielsweise die Fissura petrotympanica oder die

Fossa pterygoidea am Processus condylaris. Die Darstellung der

Gelenkoberflächen war in vivo bislang nur mit Hilfe der Arthroskopie und den

damit einhergehenden operativen Risiken möglich [63].

1.2.3.2 Aufnahmetechnik zur Darstellung des Kiefergelenks in CT-

Aufnahmen

Bei der Anfertigung der Computertomographie-Aufnahmen des Kiefergelenks

muss sorgfältig darauf geachtet werden, dass der Patient sich nicht bewegt, da

die CT aufgrund ihrer relativ langen Aufnahmezeit anfällig für

Bewegungsartefakte ist [63]. Durch die Einführung der Spiral-Computer

Tomographie wurde die Aufnahmezeit verkürzt, und somit die Anfälligkeit für

Bewegungsartefakte deutlich reduziert [77]. Trotzdem sind bei der Anfertigung

von CT-Aufnahmen verschiedene Maßnahmen zu ergreifen, um die Qualität zu

verbessern. Der Kopf des Patienten wird symmetrisch in der Kopfschale

gelagert und mit Klettband fixiert. Die Lage des Unterkiefers ist durch eine

Aufbißschiene aus einem radiotransparenten Material zu sichern, um spontane

Bewegungen des Unterkiefers, zum Beispiel Spasmen der Kaumuskulatur

während der Strahlenexposition zu verhindern. Das Kinn kann mit Klebeband

an der Haut der Jochbeinregion fixiert werden [52].

Bei einer gewöhnlichen CT-Aufnahme des Kiefergelenks erhält man eine

Abbildung in der horizontalen Ebene. Die Art und Weise, wie der Kliniker das

Kiefergelenk und seine Bewegungsabläufe betrachtet, macht in häufigen

Fragestellungen eine Darstellung in sagittalen Schichten wünschenswert.

Prinzipiell lässt sich eine herkömmliche CT-Aufnahme zu einer Abfolge
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sagittaler Slices rekonstruieren, jedoch ist dieses Procedere mit einigen

Nachteilen verbunden. Es ist eine große Anzahl von Schichten und eine damit

verbundene hohe Strahlenbelastung bei der ursprünglichen Aufnahme

notwendig und die Bildqualität nimmt bei einer rekonstruierten Aufnahme durch

Messwertinterpolation ab. Van der Kuijl et al. haben 1990 eine direkte sagittale

Aufnahmetechnik entwickelt. Mit Hilfe eines modifizierten Patiententisches,

einer speziellen Kopfstütze, maximaler Neigung des Gantrys und einer eigens

entwickelten seitlichen Patientenlagerung bei maximaler Lateroflexion des

Kopfes kann ein Strahlengang erreicht werden, der eine sagittale Aufnahme

des Kiefergelenks ermöglicht [79].

Honda et al. verglichen 2001 die Ortho cubic super-high resolution computed

tomography (Ortho-CT) mit herkömmlichen Röntgenaufnahmen. Bei der Ortho-

CT sammelt ein einzelner 360° Scan Projektionsdaten, aus denen ein

dreidimensionales Bild mit der Form eines Zylinders rekonstruiert wird, mit der

Höhe von 32 mm und einem Durchmesser von 38 mm. Die Bilder haben eine

höhere Auflösung bei geringerer Strahlendosis als die herkömmliche Computer

Tomographie. Die Ortho-CT, die nicht mehr Platz benötigt als ein OPG, wurde

ursprünglich für die Untersuchung der dentalen und maxillofacialen Region

entwickelt. Allerdings hat die klinische Erfahrung auch seinen erfolgreichen

Einsatz bei der Diagnostik von Kiefergelenkserkrankungen gezeigt.

Herkömmlichen Röntgenverfahren ist es in Bezug auf sein diagnostisches

Potential überlegen und ist hier vergleichbar mit gewöhnlichen CT-Aufnahmen.

Der Nachteil ist die mit 17 Sekunden recht lange Aufnahmezeit, so dass auch

hier eine Fixierung des Kopfes notwendig ist [32].

1.2.3.3 Messungen anhand von CT-Aufnahmen

Vermessungen an CT-Aufnahmen sind zuverlässig verwendbar, da die

Messwerte mit den anatomischen Abmessungen übereinstimmen [11, 59]. Auf

herkömmlichen zweidimensionalen Röntgenbildern sind Messungen der

räumlichen Tiefe, also der Dicke einer biologischen Struktur nicht möglich. CT-
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Aufnahmen bieten diese Möglichkeit. Zudem sind die Messungen an CT-

Aufnahmen auf den Bruchteil eines Millimeters genau [87].

Togashi et al. fanden 2002 heraus, dass die Messfehler an CT-Aufnahmen bei

linearen Messungen kleiner als 5% waren, sofern die Schichtdicke der

Aufnahme nicht größer als 3 mm war. Mit zunehmender Schichtdicke

vergrößerte sich auch der Messfehler [77]. 1987 untersuchten Christiansen et

al. CT-Aufnahmen des „normalen“, also nicht erkrankten Kiefergelenks von 53

Patienten und vermaßen Dimensionen, Winkel und Abstände. Sie fanden

heraus, dass der Kondylus in der horizontalen Ebene in 40% der Fälle eine

elliptische, in 40% eine konkavkonvexe und in 20% eine ovoide Form hat.

Außerdem wurde der antero-superiore sagittale Gelenkspalt (1,9 mm), der

koronale zentral-superiore Gelenkspalt (2,3 mm) und der medial-horizontale

Gelenkspalt vermessen (3,9 mm) [16]. Waitzmann et al. verglichen 1992 direkte

Streckenmessungen an Schädeln im Bereich der Orbita mit indirekten

Messungen an CT-Aufnahmen. Die durchschnittliche Differenz zwischen beiden

Methoden betrug nur 0,9% bei exakt axial angefertigten CT-Aufnahmen. Bei

nicht axial aufgenommenen CT-Aufnahmen nahm die Differenz etwas zu.

Wurden die Aufnahmen mit einer Achsenabweichung von ±4° aufgenommen,

war bei 65% der Messungen der Fehler kleiner als 2%, und bei 95% der

Messungen kleiner als 5%. Nach Meinung der Autoren liegen auch diese

Ergebnisse in einem klinisch akzeptablen Rahmen [83].

Auch Cavalcanti et al. verglichen 1999 direkte und an CT-Aufnahmen indirekt

durchgeführte Messungen linearer Interlandmark-Distanzen und fanden keinen

signifikanten Unterschied zwischen beiden Methoden. Sie folgerten, dass die

Genauigkeit der Messungen an CT-Aufnahmen für präoperative Planungen

ausreiche [13]. Im selben Jahr untersuchten Kusnoto et al. ebenfalls im

Vergleich zur direkten Methode, Messungen von Interlandmark-Distanzen und

Winkeln an CT-Aufnahmen mit besonderem Augenmerk auf den Einfluss von

Kopfrotationen von 5° während der Aufnahme. Sie folgerten aus ihren

Ergebnissen, dass Ungenauigkeiten bei der Identifizierung der landmarks die

größere Fehlerquelle im Vergleich zur Rotation darstellt [38].
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Auch Volumenmessungen an CT-Daten sind bereits validiert worden. Roth et

al. haben 1997 die Genauigkeit von volumetrischen Messungen der Mandibula

untersucht. Sie haben direkte Messungen mit indirekten Messungen an CT-

Daten verglichen. Zur direkten Messung wurden die Volumina von Unterkiefern

von Leichen durch Wasserverdrängung bestimmt. Die indirekte Messung

anhand von CT-Aufnahmen erfolgte durch die schichtweise Zählung der

beteiligten Voxel. Ein Voxel ist ein Volumenelement, dessen Größe sich aus

dem Produkt seiner von der verwendeten Auflösung abhängigen Grundfläche

und der Schichtdicke der CT-Aufnahme ergibt. Das Volumen der Mandibula

lässt sich durch die Multiplikation der ermittelten Voxel-Anzahl und dem Voxel-

Volumen errechnen. Sie fanden eine durchschnittliche Abweichung zwischen

beiden Verfahren von weniger als 5% [49, 65]. Im selben Jahr verglichen Kane

et al. verschiedene Methoden der Volumenmessung an Kunststoff-

Phantommodellen unterschiedlicher Form. Sie bestimmten die Volumina durch

Vermessungen mit Hilfe von Schieblehren und indirekt anhand von CT-

Aufnahmen. Sie fanden einen durchschnittlichen Unterschied von nur 2,2%

zwischen den beiden Messverfahren [35]. So wurden in verschiedenen Studien

anhand von CT-Aufnahmen die Volumina nicht nur von der Mandibula, sondern

auch von einzelnen Kaumuskeln bestimmt [34, 36, 45].
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1.3 Landmarks zur Beschreibung radiologischer Strukturen

Zur Beschreibung biologischer Strukturen, seien es Kurven, Oberflächen oder

Volumina, hat sich die Definition von Bezugspunkten, so genannten landmarks

etabliert.

Bereits um 1490 begann Leonardo da Vinci mit seinen anatomischen

Untersuchungen an menschlichen Leichnamen. Trotz des ausdrücklichen

päpstlichen Verbotes schuf da Vinci ein etwa 200 Seiten fassendes

anatomisches Werk. Er versuchte die menschliche Schönheit mit Hilfe von

Bezugspunkten und konstruierten Linien in geometrischen Regeln

auszudrücken.

Abbildung 1.5: Menschlicher Schädel, Leonardo da Vinci, um 1500.

Landmarks sind definiert als biologisch bedeutungsvolle Punkte, die

unmissverständlich beschrieben werden können und sich wiederholbar an

biologischen Strukturen lokalisieren lassen. Die wichtigste Anforderung an ein

landmark ist, dass es leicht zu identifizieren ist und mit einem hohen Grad an

Genauigkeit und Präzision lokalisiert werden kann. Nur wenn ein landmark

unter allen Bedingungen zu finden ist, ist dieser sinnvoll für Analysen zu

verwenden. Landmarks können beispielsweise an Foramina, Schnittpunkten
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von Suturen oder knöchernen Fortsätzen liegen. Unter homologen landmarks

versteht man landmarks, die korrespondierend bei verschiedenen Organismen

im Sinne einer Kontinuität der enthaltenen Information zu finden sind [40, 62].

1.3.1 Landmarks in der Anthropologie

Landmarks wurden bereits vor über einem Jahrhundert in der Anthropologie

verwendet, um craniale Variationen zu quantifizieren. Die erste radiologische

Studie über fossile menschliche Funde wurde bereits 1906 veröffentlicht, nur elf

Jahre nach W. C. Röntgens Entdeckung der gleichnamigen Strahlung. D.

Gorganovic-Kramberger untersuchte Variationen bei Pulpenkavitäten von

Zähnen von Neandertalern. Weitere Studien befassten sich mit Zähnen,

Unterkiefern und Schädeln von Fossilien. In den 1980er Jahren wurden die

ersten CT-Scans von fossilen Schädeln angefertigt und die Fortschritte im

Bereich der digitalen Bildverarbeitung ermöglichten geometrisch exakte

dreidimensionale Bildgebung von fossilen Schädeln, so dass intracraniale

Messungen vorgenommen werden konnten [76]. In etlichen Studien wurden

beispielsweise das Os temporale und die Fossa articularis unter Zuhilfenahme

dreidimensionaler landmarks anhand von CT-Datensätzen vermessen und

zwischen verschiedenen hominiden Fossilien, Primaten und modernen

Menschen verglichen [29, 42, 70, 71]. Hennessy und Stringer untersuchten

2002 mit Hilfe von Distanzen zwischen paarigen wie unpaarigen landmarks die

regionalen Unterschiede der craniofacialen Form des modernen Menschen

[31].
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1.3.2 Landmarks in der zweidimensionalen Kephalometrie

Seit den 1930er Jahren fanden landmarks auch klinische Anwendung bei der

facialen Anthropometrie bei Patienten mit Lippen- Kiefer- Gaumenspalten und

zur Beschreibung hemifacialer Asymmetrien [23].

Die kephalometrische Analyse in der Kieferorthopädie verwendet ebenfalls

landmarks. Durch die Identifikation kephalometrischer Bezugspunkte können

anschließend Winkel- und Streckenmessungen vorgenommen werden. Bei den

über 200 in der Literatur beschriebenen Bezugspunkten handelt es sich um

landmarks an der Schädelbasis, der Maxilla, der Mandibula und im Bereich der

Dentition. Grundsätzlich werden verschiedene Messpunktarten unterschieden.

Anatomische Punkte werden durch anatomische Strukturen eindeutig bestimmt.

Anthropologische Punkte sind Extrempunkte von anatomischen Konturen. Ihre

Lage ist nicht immer exakt definiert, da sie von der Lagerung und Neigung des

Kopfes abhängig sind. Konstruierte Punkte werden erst durch geometrische

Konstruktionen ermittelt. Röntgenologische Punkte sind durch die durch

Überlagerungen anatomischer Strukturen entstehenden Schnittpunkte definiert.

Mögliche Ungenauigkeiten erklären sich mit verschiedenen Fehlerquellen.

Radiographische Fehler sind röntgentechnische und projektorisch bedingte

Fehler, wie zum Beispiel Verzerrung und Vergrößerung oder die falsche

Lagerung eines Patienten. Messfehler entstehen bei der analytischen

Auswertung der Bezugspunkte. Die wohl gravierendste Fehlerquelle stellt der

Identifikationsfehler dar. Die Größe des durch fehlerhafte Interpretation der

anatomischen Strukturen entstehenden Fehlers ist in hohem Maße vom

Übungsgrad des Untersuchers abhängig [67].

1971 untersuchten Baumrind und Frantz sechzehn Standard-landmarks in

Bezug auf die Präzision bei ihrer Identifizierung. Die Studie zeigte, dass der

durch Ungenauigkeiten bei der Identifizierung der landmarks entstehende

Fehler einen nicht zu vernachlässigenden Einfluss auf eine anschließende

cephalometrische Analyse hat. Es wurden deutliche Unterschiede zwischen

verschiedenen landmarks gefunden. So lassen sich landmarks an anatomisch
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markanten Positionen wie knöchernen Kanten oder Foramina genauer

reproduzieren als landmarks an Kurven. Sie fanden, dass die Fehler für jeden

landmark eine charakteristische Verteilung aufwiesen, und folgerten, dass die

Fehler nicht rein zufällig, sondern je nach Beschaffenheit des landmarks

systematisch zustande kommen. Sie schlugen vor, die Fehler bei der

Identifizierung zu reduzieren, indem alle landmarks routinemäßig mehrfach

lokalisiert werden [5].

Midtgard et al. beschrieben 1974 die Reproduzierbarkeit von landmarks in FRS-

Aufnahmen. Sie fanden, dass landmarks in Abhängigkeit von

Abbildungsschärfe und Kontrast im Bereich der äußeren Schädelkontur relativ

leicht zu identifizieren sind. Landmarks im Inneren des Schädels seien häufig

ungenauer aufgrund der Summation überlagerter anatomischer Strukturen. Sie

zeigten, dass die intraindividuelle Abweichung im Durchschnitt etwa 1 mm

beträgt. Ein Testintervall von einem Monat hatte keinen signifikanten Einfluss

auf das Ergebnis. Sie folgerten, dass die Unterschiede zu großen Teilen von

der Unsicherheit des Untersuchers beim Platzieren der landmarks abhängen.

Bei einem interindividuellen Vergleich erzielten beide Untersucher ähnliche

Ergebnisse [47].

McWilliams und Welander beschäftigten sich 1978 mit dem Einfluss der

Bildqualität auf die Genauigkeit der landmarks. Sie zeigten, dass Auflösung und

Kontrast des Röntgenbildes maßgebliche  Faktoren darstellen. Weitere wichtige

Einflussgrößen seien projektorische Fehler, die Art des jeweiligen landmarks,

die Darstellung anatomischer Details, Ungenauigkeiten durch Überlagerungen

und Erfahrung und radiologisches Wissen des Untersuchers. Sie bestimmten

eine minimale Auflösung, unter welcher der Fehler in der landmark-

Identifizierung signifikant zunahm. Durch den Einsatz von Verstärkerfolien ließe

sich die Strahlendosis ohne negative Auswirkung auf die Genauigkeit der

landmarks reduzieren [46].

Stabrun und Danielsen fanden 1982 eine hohe Präzision bei einem

intraindividuellen Vergleich und folgerten, dass jeder Untersucher eine klare

Vorstellung von der definierten Position der vierzehn untersuchten landmarks

hat. Bei dem interindividuellen Vergleich erzielten sie zwar generell gute
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Ergebnisse, bei der Lokalisierung einiger weniger landmarks traten jedoch

größere Unstimmigkeiten auf. Sie forderten eine klarere Definition der Position

der landmarks und eine intensivere Kalibrierungen der Untersucher, um Fehler

bei der Identifizierung von landmarks durch unterschiedliches Verständnis einer

landmark- Definition zu vermeiden. Übereinstimmend mit Baumrind und Frantz

[5] beschrieben sie ein charakteristisches Bild der Identifikationsfehler für jeden

landmark in Abhängigkeit der spezifischen Konditionen, die mit der

Lokalisierung verbunden sind [73].

El-Mangoury et al. bemerkten 1987, dass möglichen Ungenauigkeiten bei der

Lokalisierung der landmarks häufig nicht die nötige Aufmerksamkeit zuteil wird

und somit Daten aus kephalometrischen Analysen in Frage gestellt werden

müssen. Sie fanden heraus, dass in poterior-anterioren Röntgenaufnahmen

skeletale landmarks genauer zu reproduzieren sind als dentale. Die

Identifikation einzelner landmarks ist zuverlässiger als die Identifikation von

Flächen, da hierzu mehrere landmarks notwendig sind und mögliche Fehler

sich addieren können [22].

Major et al. fanden 1994 bei ihrer Untersuchung von landmarks in

Fernröntgenfrontalaufnahmen auf ihre Verlässlichkeit signifikante Unterschiede

zwischen den intraindividuellen und den interindividuellen Identifikationsfehlern.

Auch sie erkannten landmarks, die je nach ihrer Definition größere Fehler in der

Horizontalen oder der Vertikalen aufwiesen. Sie diskutierten, ob das genaue

Wissen um die Fehlercharakteristika eines jeden verwendeten landmarks einen

positiven Effekt in Bezug auf die Genauigkeit und Verlässlichkeit der Analyse

haben könnte [43].

Athanasiou et al. errechneten 1999 aus allen ihren gemessenen landmark-

Positionen Mittelwete für die x- und y-Koordinate, um eine möglichst „wahre“

Position des landmarks als Referenz zu erhalten, da eine exakte Position für ein

landmark nicht existiert und auch Experten über die ideale Position

unterschiedlicher Ansicht sind. Sie zeigten signifikante Unterschiede in der

Genauigkeit verschiedener landmarks und nur geringe Unterschiede zwischen

verschiedenen Untersuchern. Auch in dieser Studie wurde eine für jeden

landmark charakteristische Verteilung der gemessenen Positionen beschrieben.
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So liegt bei einigen landmarks der Fehler eher auf der x-, bei anderen eher auf

der y-Achse. Für paarige landmarks wurde auf beiden Seiten weit gehend

übereinstimmende Ergebnisse erzielt [4].

1.3.3 Landmarks im dreidimensionalen Raum

Die Anwendung von landmarks im dreidimensionalen Raum begann durch die

Stereolokalisierung von landmarks durch die Kombination von

Fernröntgenseiten- und Fernröntgenfrontalaufnahmen. Diese zweiflächige

Rekonstruktion von dreidimensionalen landmark-Positionen galt als praktikabler

Kompromiss zwischen Genauigkeit und Kosten zur Untersuchung der

dreidimensionalen kranialen Form. Bei einem Vergleich dieser Methode mit

Schieblehrenmessungen fanden Bookstein et al. nur Abweichungen von

durchschnittlich 0.4 mm bei den Interlandmark-Distanzen. Probleme dieser

Methode waren die relativ geringe Anzahl von geeigneten landmarks und die

hohe Fehlerquelle durch die Notwendigkeit, alle landmarks auf zwei

verschiedenen Röntgenbildern identifizieren zu müssen. So entwickelten Brown

und Abbott ein computerunterstütztes Verfahren bei dem mit Hilfe einer

radiographischen Gleichung basierend auf der Geometrie eines zweiflächigen

Systems die Lage eines landmarks auf dem zweiten Röntgenbild durch seine

Lage auf dem ersten Röntgenbild vorhergesagt werden konnte. Die ermittelten

dreidimensionalen landmark-Koordinaten konnten für metrische Analysen oder

zur Darstellung des Schädels als „Drahtmodell“ verwendet werden. [7, 10].

Nachteile der herkömmlichen cephalometrischen Röntgenbilder sind vor allem

Ungenauigkeiten durch Überlagerungen und eine relativ geringe Anzahl an

präzise zu lokalisierenden landmarks. Aus diesem Grund wurden landmarks

geschaffen, die aus geometrischen Regeln und Positionen anderer landmarks

konstruiert werden müssen, was eine zusätzliche Fehlerquelle bedeutet. Bei der

Computer Tomographie gibt es keine Probleme durch Überlagerungen,

Vergrößerungen oder Verzerrungen. Sie bietet eine große Anzahl an

geeigneten landmarks im dreidimensionalen Raum, die Messungen sind
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genauer als bei herkömmlichen Röntgenbildern und der interindividuelle Fehler

ist kleiner [85].

Neben etlichen landmarks auf zweidimensionalen Röntgenbildern, sind bereits

mehrfach landmarks im dreidimensionalen Raum an CT-Daten validiert worden.

So sind bereits mit Hilfe von landmarks Formvergleiche, lineare, volumetrische

und Winkel- Messungen  und verschiedene Wachstumsmuster im Bereich des

Schädels beschrieben worden.

Bei Formvergleichen wurde in verschiedenen Studien die durchschnittliche

Form einer Population errechnet und mit einer anderen verglichen. Mit Hilfe

einer gemittelten Matrix aus Interlandmark-Distanzen können verschiedene

Individuen oder Gruppen gegenüber gestellt und auf signifikante Unterschiede

untersucht werden. So wurden beispielsweise Klassifikationen für knöcherne

Missbildungen erstellt [33] und Schädelformen und Wachstumsmuster von

syndromalen Patienten beschrieben [51, 88]. Als mathematische Grundlage für

diese Formvergleiche diente die von Lele und Richtsmeier entwickelte

„Euclidean Distance Matrix Analysis“ (EDMA). Mit dieser auf landmarks

basierenden Methode lassen sich Formen und Wachstumsmuster im

zweidimensionalen und dreidimensionalen vergleichen. Durch die Erstellung

einer Matrix aus den Interlandmark-Distanzen ist diese Methode unabhängig

von den verwendeten Koordinatensystemen oder von röntgenologischen

Einflüssen, wie zum Beispiel Rotationen. Dadurch können verschiedene

Aufnahmen von verschiedenen Patienten gegenübergestellt werden. Es werden

die Verhältnisse zwischen allen homologen Interlandmark-Distanzen berechnet,

um die relativen Unterschiede zwischen zwei Schädeln zu beschreiben. Die

EDMA wurde in mehreren Studien entwickelt und beschrieben [20, 39, 40, 41,

60, 61].

In den vergangenen fünfzehn Jahren sind mehrfach landmarks im Bereich des

Schädels anhand von CT-Aufnahmen auf ihre Genauigkeit und intra- wie

interindividuelle Reproduzierbarkeit untersucht worden.

Abbott et al. ließen 1990 den Untersucher die 76 landmarks zweimal

identifizieren mit einer einmonatigen Pause zwischen den beiden Durchläufen.

Durch diese Pause sollten Erinnerungen an einzelne anatomische
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Besonderheiten der verschiedenen CT-Aufnahmen und damit an die im ersten

Durchgang gewählten Positionen der landmarks vermieden werden. Für zwölf

landmarks wurden auf diese Weise signifikante Abweichungen gefunden. Das

heißt, das Verständnis der Definition der landmarks hat sich für den

Untersucher verändert. Sie folgerten, dass exaktere Definitionen der landmarks

ihrer Reproduzierbarkeit verbessern könnten. Die gemessenen Abstände lagen

zwischen 0,411 mm und 5,165 mm, der durchschnittliche Fehler bei 1,7 mm,

was in den verwendeten CT-Aufnahmen in etwa der Größe zweier Voxel

entspricht. Bei der selben Untersuchung an herkömmlichen zweidimensionalen

Röntgenbildern wurde ein durchschnittlicher Fehler von nur 0,7 mm gefunden.

Bei Patienten mit syndromalen Erkrankungen oder Asymmetrien sind die

herkömmlichen Bilder jedoch häufig schwer zu interpretieren, so dass in diesen

Fällen die Computer Tomographie die Identifizierung einer größeren Anzahl von

landmarks ermöglicht. Eine Untersuchung mit CT-Aufnahen von Patienten mit

Weichgewebs- oder knöchernen Abnormalitäten zeigte, dass diese keinen

negativen Einfluss auf die Genauigkeit der landmarks haben. Sie folgerten,

dass die Genauigkeit und Reproduzierbarkeit der landmarks die Beschreibung

des craniofacialen Systems ermöglichen und diese somit für die Analyse und

Quantifizierung der craniofacialen Morphologie in drei Dimensionen geeignet

sind [1].

Richtsmeier et al. beschrieben 1995 verschiedene Arten von Fehlern in der

Anwendung von landmarks. Fehler bei der Herstellung eines digitalen Bildes

vom lebenden Objekt, Fehler beim Identifizieren der landmarks im digitalen Bild

und Fehler die durch die nicht korrekte Nutzung der Hard- und Software

entstehen. Von zehn Schädeln wurden je zwei Aufnahmen angefertigt, auf jeder

Aufnahme wurden die landmarks zweimal identifiziert. Unterschiede in den

gemessenen Daten von zwei verschiedenen Aufnahmen des selben Schädels

sind bedingt durch Fehler bei der Anfertigung des digitalen Bildes. Differenzen

zwischen Daten, die zu unterschiedlicher Zeit vom selben Bild erhoben wurden,

sind abhängig von Fehlern, die beim Aufzeichnen der landmarks durch die

Interaktion von Untersucher und verwendeter Hard- und Software entstehen.

Da die Auswertung der Daten anhand von Koordinatensystemen nicht ohne
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weiteres möglich ist, da bei verschiedenen Aufnahmen die Nullpunkte der

Koordinatensysteme in Bezug auf das dargestellte Objekt an verschiedenen

Stellen liegen und somit ein Vergleich der Daten durch ein Übereinanderlegen

der Aufnahmen nicht durchführbar ist, entschied man sich, in Anlehnung an die

„Euclidean Distance Matrix Analysis“ eine Matrix aus Interlandmark-Distanzen

zu erstellen um mögliche Differenzen statistisch zu erfassen. Die

durchschnittlich Differenz der landmark-Positionen auf ein und demselben Bild

betrug nur 0,5 mm, die durchschnittliche Differenz der landmark-Positionen auf

zwei verschiedenen Aufnahmen des selben Schädels lag je nach Schädel

zwischen 0,17 mm und 0,53 mm. Die Autoren folgerten, dass die Genauigkeit

und Reproduzierbarkeit der landmarks in CT-Aufnahmen die Untersuchung der

biologischen Geometrie mit akzeptabler Präzision ermöglicht. Richtsmeier

beschreibt eine weitere Besonderheit, die mit der Darstellung durch

Schichtbilder einhergeht. Die Pixelgröße betrug im vorliegenden Fall 0,39 mm x

0,39 mm, die Schichtdicke 1,5 mm. Damit war die Auflösung in der x- und der y-

Achse viermal größer als in der z-Achse. Er vermutete, dass die Nutzung

dreidimensional rekonstruierter CT-Aufnahmen weniger arbeitintensiv sei und

keine Erfahrung im Umgang mit Schichtbildern voraussetze. Allerdings würden

bei der Rekonstruktion keine neuen Daten hinzugefügt, so dass mit einer

erhöhten Genauigkeit und Präzision nicht zu rechnen sei [62].

Kragskov et al. verglichen 1997 landmarks in konventionellen

cephalometrischen Röntgenaufnahmen mit landmarks in CT-Aufnahmen in

Bezug auf ihre Zuverlässigkeit. Sie fanden interindividuelle Differenzen von

weniger als 1 mm bei den konventionellen Röntgenbildern und Differenzen von

etwa 2 mm bei CT-Aufnahmen. Sie folgerten, dass bei herkömmlichen

Analysen die Anfertigung konventioneller Röntgenbilder ausreichend sei. Bei

Patienten mit Asymmetrien und craniofacialen Syndromen sei die Computer

Tomographie indiziert [37].

Cavalcanti und Vannier untersuchten mögliche Unterschiede in der Genauigkeit

von landmarks in zweidimensional und dreidimensional rekonstruierten CT-

Aufnahmen und verglichen die Ergebnisse mit direkten Messungen am

Schädel. Sie fanden für die Messungen an dreidimensional rekonstruierten CT-
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Aufnahmen bessere Ergebnisse als für die an zweidimensional rekonstruierten

CT-Aufnahmen durchgeführten Messungen. Keine an dreidimensional

rekonstruierten CT-Aufnahmen durchgeführte Messungen unterschied sich

signifikant von den direkten Messungen, bei den an zweidimensional

rekonstruierten CT-Aufnahmen durchgeführten Messungen gab es bei jeder

vierten einen signifikanten Unterschied. Aber auch die zweidimensional

rekonstruierten CT-Aufnahmen lieferten eine akzeptable Genauigkeit. Die

Messung der bikondylären Distanz wies beispielsweise nur eine

durchschnittliche Differenz von 0,22 mm im Vergleich zur direkten Messung auf

[15].

Cavalcanti et al. untersuchten 2004 die Präzision und Genauigkeit von

craniofacialen landmarks an dreidimensional rekonstruierten CT-Aufnahmen

indem sie Interlandmark-Distanzen mit direkten Messungen am Schädel

verglichen. An der Studie nahmen zwei Radiologen teil, so dass die intra- und

interindividuelle Reproduzierbarkeit beurteilt werden konnte. Sie fanden keine

signifikanten Unterschiede zwischen den intra- und interindividuellen

Messungen und auch keine signifikanten Abweichungen zwischen der

indirekten und der direkten Methode [14].

1.3.4 Fuzzy landmarks

Valeri et al. begründeten 1998 eine neue Klasse von landmarks. Ein Fuzzy

landmark repräsentiert die Position einer biologischen Struktur, die präzise

skizziert ist, aber ein größeres Areal als ein einzelner Punkt einnimmt. Es

handelt sich hierbei um Flächen, denen die Eigenschaften oder markante

Besonderheiten für die Definition eines einzelnen Punktes fehlen, die aber eine

topographische Bedeutung haben. Solche Flächen existieren an vielen

biologischen Objekten. Es könnte sich beispielsweise um Gelenkflächen,

Insertionsstellen von Muskeln an Knochen, um eine Weichgewebsstruktur oder
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eine Fossa handeln. Ein Fuzzy landmark liegt im angenommenen Zentrum des

Areals.

In der durchgeführten Studie war der Messfehler bei den Fuzzy landmarks zwar

größer als bei herkömmlichen landmarks, lag aber mit einer durchschnittlichen

Varianz von 1,15 mm in einem akzeptablen Rahmen, besonders da durch diese

neue Art der landmarks neue Areale für die Untersuchung durch landmarks

erschlossen werden, die mit herkömmlichen landmarks nicht zu beschreiben

waren. Durch wiederholte Lokalisierung und statistische Auswertung der

gemessenen Abstände konnten durch die erzielten Ergebnisse Fuzzy

landmarks etabliert werden. Grundsätzlich ist diese Methode auch auf andere

anatomische Strukturen übertragbar, jeder neu definierte Fuzzy landmark

bedarf jedoch einer genauen Untersuchung bezüglich seiner

Reproduzierbarkeit. Mögliche Anwendungsgebiete der Fuzzy landmarks sind

Wachstumsstudien, klinische Messreihen und Volumenmessungen [78].

Williams und Richtsmeier stellten 2003 fest, dass der Unterkiefer aufgrund der

geringen Anzahl markanter anatomischer Punkte und Strukturen, die sich als

landmarks eigneten, nur schwerlich durch landmarks zu quantifizieren ist. Sie

definierten daher insgesamt sieben Fuzzy landmarks im Bereich des Kondylus,

des aufsteigenden Astes und des Kinns. Zusätzlich bezogen sie einige

konstruierte landmarks in ihre Studie mit ein. Auch sie stellten für die Fuzzy

landmarks und die konstruierten landmarks  größere Fehler als für die

biologischen landmarks fest, fanden aber für alle landmarks akzeptable

Fehlerradien [86].
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1.4 Ziel der Studie

Trotz intensivster Forschung zur Gelenkposition existieren bisher nur wenige

evidente Fakten über eine anatomische dreidimensionale physiologische

Position des Condylus zur Fossa.

Dass eine Gesetzmäßigkeit bzw. eine Symmetrie in der biologischen Variation

von Condylus zur Fossa besteht, wurde bereits 1899 von dem Anthropologen

Aurel von Török bestritten [82]. Er stellte an 905 Schädeln mit Unterkiefer fest:

..., dass weder die Form, noch die Flächenausdehnung der Gelenkgrube ein

solches, für alle möglichen vorkommenden Einzelfälle gültiges Verhältnis

aufzustellen gestattet, aus welchem auf die spezielle Form und Größe der

Gelenkköpfe des Unterkiefers ein sicherer Rückschluss gezogen werden

könnte. Um nun die Aussagen in dreidimensionaler Hinsicht zu komplettieren

fügt von Török hinzu: ... spielt die Stellung der Gelenkköpfe eine wesentliche

Rolle, und könnte ihre Richtung in den Gelenkgruben ohne weiteres genau

bezeichnet werden, so wäre dieses einzige Moment schon für sich allein

hinreichend, um die Entscheidung einer Zusammengehörigkeit ganz sicher

treffen zu können. Leider ist das nicht der Fall.

Die Simplifizierung der dreidimensionalen Struktur des Kiefergelenkes auf eine

zweidimensionale Projektion, wie in vielen bildgebenden Verfahren der Fall,  ist

für therapeutische Positionierungen des Condylus zur Fossa also fragwürdig.

Hier stellt sich nun die Frage, ob nicht der dreidimensionale Gelenkspalt die

geeigneten Informationen der räumlichen Positionierung von Condylus zur

Fossa beinhaltet.

Es soll eine Methode entwickelt werden, mit der sich anhand von

computertomographischen Aufnahmen das Volumen des Gelenkspalts

bestimmen lässt. Hierzu wurden landmarks definiert, die die volumetrischen

Grenzen des Kiefergelenks markieren. Voraussetzung für eine korrekte

Volumenbestimmung des Gelenkspalts ist die exakte Definition und

Reproduzierbarkeit der benutzten landmarks.
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Das Ziel der vorliegenden Studie ist es,

1) die neu definierten landmarks im Bereich des Kiefergelenks in Bezug auf

ihre Reproduzierbarkeit in Computertomographie-Aufnahmen zu

untersuchen und mit schon validierten landmarks am Schädel zu

vergleichen;

2) eine Anleitung zu erstellen, wie eine Computertomographie-Aufnahme

des Kiefergelenks anhand der von uns entwickelten und validierten

landmarks mit der verwendeten Software ImageJ [58]  unter zu

Hilfenahme einer für diesen Zweck programmierten Applikation im

dreidimensionalen Raum entsprechend der Grundebene ausgerichtet

werden kann.
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2 Material und Methode

2.1 Reproduzierbarkeit der landmarks

Um die interindividuelle Reproduzierbarkeit der von uns für die volumetrische

Evaluation des Gelenkspalts definierten landmarks besser beurteilen zu

können, wurden bereits etablierte landmarks in die Auswertung mit einbezogen.

2.1.1 Definition der landmarks

Man unterscheidet verschiedene Typen bzw. Klassen von landmarks. So finden

sich unter den hier untersuchten landmarks zum einen radiologisch-anatomisch

definierte Punkte im Bereich des Mittelgesichts, zum anderen aber auch so

genannte fuzzy-landmarks. Die Definition eines fuzzy-landmark ist dabei

weiträumiger als die Definition eines herkömmlichen anatomischen Punktes und

entspricht weniger einer klar festgelegten radiologisch dargestellten Struktur,

sondern eher einer annähernden Beschreibung eines interessierenden Areals,

die je nach Untersucher unterschiedlich ausfallen kann. Die Tabelle 2.1 zeigt

eine Zusammenfassung der untersuchten landmarks.

Tabelle 2.1: Überblick über die untersuchten landmarks

Name des landmark Abkürzung Region Seite Typ
Meatus acusticus externus MAE tmj r + l radiologisch-anatomisch
Spina ossis sphenoidalis SOS tmj r + l radiologisch-anatomisch
Tuberculum articulare anterior TAA tmj r + l radiologisch-anatomisch
Os temporale laterale OTL tmj r + l radiologisch-anatomisch
Fuzzy condyle FC fuzzy r + l fuzzy
Fuzzy lambda FL fuzzy medial fuzzy
Fuzzy sella FS fuzzy medial fuzzy
Laterale orbita LO Orbita r + l radiologisch-anatomisch
Os temporale mediale OTM Orbita r + l radiologisch-anatomisch
Mediale orbita MO Orbita r + l radiologisch-anatomisch
Foramen incisivum FI Mittelgesicht medial radiologisch-anatomisch
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Abbildung 2.1 bis Abbildung 2.9 zeigen die detaillierten Regionen der

landmarks, die zur Grenzbestimmung des Kiefergelenks herangezogen wurden.

Abbildung 2.1: Meatus acusticus externus (MAE)

Der Meatus acusticus externus bildet die dorsale Begrenzung der Gelenkgrube.

Der Punkt liegt in der Schicht der unteren und lateralen Begrenzung des

Meatus acusticus externus. Die Weichteilöffnung (schwarz) berührt so gerade

die knöcherne Begrenzung (hell).
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Abbildung 2.2: Spina ossis sphenoidalis (SOS)

Die Spina ossis sphenoidalis stellt die mediale Begrenzung der Gelenkgrube

dar. Hier liegt die Verlängerung der Fissura petrotympanica (Glaser´sche

Spalte) nach medial. Der Punkt wird im kaudalen Bereich der Spina ossis

sphenoidalis in den Eingang der Spalte gesetzt.
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Abbildung 2.3: Tuberculum articulare anterior (TAA)

Das Tuberculum articulare anterior ist die anteriore Begrenzung der

Gelenkgrube. Der Punkt liegt auf der Erhebung des Tuberculum articulare

anterior. Die knöcherne anteriore Begrenzung des Kiefergelenks ist gerade

noch durchgängig sichtbar.
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Abbildung 2.4: Os temporale laterale (OTL)

Der Punkt Os temporale laterale legt die laterale Begrenzung der Gelenkgrube

fest. Die knöcherne Struktur des Os temporale ist lateral gerade noch

durchgängig sichtbar.

Abbildung 2.5: Fuzzy condyle (FC)

Fuzzy condyle liegt im Mittelpunkt des Condylus in der Schichtebene seiner

größten Ausdehnung.
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Abbildung 2.6: Fuzzy lambda (FL)

Der Punkt Fuzzy lambda wird auf den Schnittpunkt der occipitalen Suturen

gesetzt.

Abbildung 2.7: Fuzzy sella (FS)

Fuzzy sella liegt im Mittelpunkt der Sella turcica. Es wird neben der

Horizontalen auch die Vertikale berücksichtigt, indem die in der Mitte der Sella

liegende Schichtebene gewählt wird.
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Abbildung 2.8: Laterale Orbita (LO), Os temporale mediale (OTM), Mediale Orbita (MO)

Die drei Punkte liegen in der Schichtebene mit der größten Öffnung des Canalis

opticus. Nervus opticus sowie Musculus rectus lateralis und medialis sind zu

erkennen.

Der Punkt Laterale Orbita ist die knöcherne anteriore und laterale Begrenzung

der Orbita.

Os temporale mediale liegt im Bereich der tiefsten medialen Einziehung des Os

temporale.

Der Punkt Mediale Orbita stellt die knöcherne anteriore und mediale

Begrenzung der Orbita dar.
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Abbildung 2.9: Foramen incisivum (FI)

Der Punkt Foramen incisivum befindet sich am Eingang des Canalis incisivus.

Der Punkt liegt in der Schichtebene, in der der Kanal das erste Mal knöchern

umschlossen ist. Er wird auf die Mitte des Kanals gesetzt.

Die Positionierung der landmarks erfolgte in einer Arbeitsgruppe. Diese bestand

aus fünf Klinikern. Die genaue Position der ausgewählten landmarks wurde

zunächst von einem Radiologen festgelegt. Diese Vorgaben wurden als

Goldstandard gesetzt. Anhand dieses Goldstandards wurden anschließend alle

teilnehmenden Untersucher kalibriert. Jeder Untersucher befolgte bei der

Positionierung der landmarks ein im Vorfeld festgelegtes Auswertungsprotokoll,

wobei mit der linken Seite der Datensätze begonnen wurde.

2.1.2 Datenerhebung und Auswertung

Bei den verwendeten Computertomographien handelt es sich um Spiral-

Computertomographien (CT-AVE, Phillips, Niederlande). Die Datensätze

wurden dem elektronischen Bildarchiv des Institutes für Klinische Radiologie

des Universitätsklinikums Münster entnommen. Zur Auswahl der Datensätze
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wurden im PACS (Picture Archiving and Communication System) die

Suchbegriffe „CT-Head“ und „CT-Angio“ verwendet. Entscheidend für die

Auswahl war, dass der knöcherne Schädel komplett abgebildet war, und dass

keine gravierenden Pathologien im Sinne syndromaler oder dysmorpher

Schädelveränderungen vorlagen. Der überwiegende Teil der

Computertomoraphien wurde bei einer Spannung von 120 kV und einer

Stromstärke von 170 mAs aufgenommen. Die verwendeten CT-Aufnahmen

wurden auf Schichtdicken von 1 mm bis 1,3 mm rekonstruiert.

Die Übertragung von digitalen Bilddaten bei derzeitigen radiologischen

Großgeräten erfolgt auf Basis bestimmter Protokolle, die spezielle Dienste zur

Verfügung stellen. Der DICOM-Standard (Digital Imaging and Communications

in M edicine) wurde  entwickelt, um eine herstellerunabhängige

Kommunikationsplattform für medizinische Bilder und bildbezogene

Informationen zu schaffen. Es werden nicht nur "nackte" Daten, sondern auch

Instruktionen und Informationen über die beabsichtigte Verwendung der Daten

innerhalb einer Nachricht mit übertragen. Mit Hilfe dieser  Nachrichten werden

bei DICOM Daten über Netzwerke ausgetauscht [54]. Über den frei erhältlichen

DICOM-Server Central Test Note des Mallinckrodt Institute of Radiology wurden

die achtzehn ausgewählten Datensätze aus dem Institutsnetzwerk auf einen

lokalen Arbeitsrechner transferiert. Die Hardwarekonfiguration des

Arbeitsrechners setzte sich aus einem G3 Power-PC Prozessor mit 333 MHz,

256 MB Ram und einer sechs Gigabyte Festplatte zusammen. Als

Betriebsystem wurde OS 8.6 verwendet. Für die weitere Bearbeitung wurde

eine Applikation programmiert, die das derzeitige Format DICOM 3 importiert.

Als Entwicklungsplattform und Auswertungssoftware diente ImageJ [58].

An der vorliegenden Studie zur interindividuellen Reproduzierbarkeit der

landmarks nahmen fünf Untersucher mit unterschiedlicher klinischer Erfahrung

teil. Zunächst wurden alle Teilnehmer im Umgang mit der Auswertungssoftware

geschult, um jedem Teilnehmer die individuell am günstigsten erscheinende

Bildeinstellung zu ermöglichen. Da das menschliche Auge in der Regel nur

zwischen 20-50 Graustufen differenzieren kann, muss der zu untersuchende

Bildausschnitt in durch das menschliche Auge auflösbaren Graustufen
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dargestellt werden. Hierzu werden so genannte Fenstereinstellungen

vorgenommen. Diese stellen die einzelnen Dichtewerte der durchstrahlten

Strukturen mit einer bestimmten Spannweite, der so genannten Fensterweite in

Hounsfield-Einheiten dar. Durch Veränderung der Fensterweite konnte jeder

Untersucher den Bildausschnitt mit den relevanten Knochenstrukturen für sich

optimiert anzeigen lassen. Anhand eines Beispiel-CT wurden alle Teilnehmer in

Bezug auf die genaue Definition der landmarks kalibriert. Jeder Untersucher

arbeitete an einer identischen digitalen Kopie der ausgewählten achtzehn

originalen CT-Datensätze. Um Fehler durch Informationsaustausch und

Konzentrationsmangel zu minimieren, wurden alle Datensätze geblindet und

nicht mehr als 140 landmarks pro Tag und Untersucher identifiziert. Alle

landmark-Koordinaten wurden zusammen mit dem zugehörigen Bild-,

Datensatz-, und Untersucher-Code sofort für die weitere statistische

Auswertung in einer lokalen Datenbank gespeichert. Nachträgliche Korrekturen

wurden damit ausgeschlossen. Zusätzlich wurde ein CT-Datensatz mit einer

Schichtdicke von 4 mm verwendet, um den Einfluss der Schichtdicke beurteilen

zu können.

Die Reproduzierbarkeit eines landmarks wurde anhand des räumlichen

Abstandes zwischen den von den verschiedenen Untersuchern festgelegten

Koordinaten für den gleichen landmark des gleichen Datensatzes beurteilt. Bei

fünf Untersuchern ergeben sich pro landmark und Datensatz zehn

Interlandmark-Distanzen.

Dieser Abstand der Koordinaten für den gleichen landmark zwischen zwei

Untersuchern (u1 ↔ u2) im Sinne eines räumlichen Fehlerradius ergibt sich aus

der Länge des zwischen den Koordinaten aufgespannten Vektors.

€ 

LMu1LMu2 =

xu2 − xu1
yu2 − yu1
zu2 − zu1

 

 

 
  

 

 

 
  

LMu1LMu2 = xu2 − xu1( )2 + yu2 − yu1( )2 + zu2 − zu1( )2

xu, yu und z u sind die Koordinaten des landmarks L Mu, die durch die

Untersucher u1 bis u5 ermittelt wurden. Der durchschnittliche interindividuelle
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Fehlerradius 

€ 

r  des landmarks LM eines Datensatzes i wurde wie folgt

berechnet:

€ 

r i =
1
10

LMu1LMu2 + LMu1LMu3 + LMu1LMu4 + LMu1LMu5

LMu2LMu3 + LMu2LMu4 + LMu2LMu5

LMu3LMu4 + LMu3LMu5

LMu4LMu5

 

 

 
 

 

 
 

 

 

 
 

 

 
 

∑

Für alle Datensätze ergibt sich daher für LM der interindividuelle Fehlerradius:

€ 

R LM =
1
18

r i
i=1

18

∑

2.1.3 Statistik

Die statistische Aufbereitung der Daten erfolgte mit Hilfe des

Statistikprogramms SPSS for Macintosh Release 11.0 (SPSS Inc., Chicago, L,

USA). Die interindividuelle Reproduzierbarkeit der landmarks wurde mit dem t-

Test für gepaarte Stichproben getestet. Die Abhängigkeit zu bestimmten

landmarks wurde mit der einfaktoriellen Varianzanalyse (ANOVA) überprüft. Es

wurden drei Signifikanzniveaus festgelegt: p≤0,001; 0,001<p≤0,01;

0,01<p≤0,05.

Die graphische Darstellung der Ergebnisse erfolgte mittels Boxplots. Zur

Interpretation eines Boxplots sind einige Erläuterungen notwendig. Der dicke
Balken im farbigen Bereich (Box) ist der Median: Würde man die Stichprobe
anhand der dargestellten Variablen „interindividuelle Distanz“ sortieren, so ist

der Median der Wert, den die Messung genau in der Mitte geliefert hat. Hätten
z.B. 99 Messungen Werte zur Variablen „interindividuelle Distanz“ geliefert, so
ist der Median der Wert, den die 50. Messung lieferte. 50% der Messdaten
insgesamt liegen in der Box: Der obere Rand der Box halbiert wiederum die
obere Hälfte der Stichprobe, der Rand liegt also am 75. Perzentil.
Entsprechendes gilt für die untere Hälfte: Der untere Rand entspricht dem 25.
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Perzentil. Die dünnen Striche zeigen die höchsten bzw. niedrigsten
beobachteten Werte, die noch keine Ausreißer sind.
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2.2 Dreidimensionale Ausrichtung einer CT-Aufnahme nach der

Grundebene des Kiefergelenks

Um eine volumetrische Vermessung des Kiefergelenks durchführen zu können,

wurden landmarks zur Grenzbestimmung des Gelenks definiert und diese auf

ihre Reproduzierbarkeit untersucht.

Abbildung 2.10: Landmarks zur Bestimmung der Gelenkspaltgrenzen

Die anteriore, die posteriore und die mediale Markierung bilden zusammen die

kaudal liegende Grundebene des zu evaluierenden Gelenkspaltes.
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Abbildung 2.11: Grundebene des Gelenkspaltvolumens

Da die oben gezeigten landmarks in der Regel in verschiedenen Schichtebenen

liegen, muss die CT-Aufnahme des Kiefergelenks als Vorbereitung für die

volumetrische Vermessung im nächsten Schritt im dreidimensionalen Raum

rotiert werden, so dass der Gelenkspalt in Bezug auf seine Grundebene

ausgerichtet wird. Der CT-Datensatz wird dabei so rotiert, dass die landmarks

MAE (Meatus acusticus externus), TAA (Tuberculum articulare anterior) und

SOS (Spina ossis sphenoidalis) in der selben Schichtebene liegen.

2.2.1 Graphische Reformatierung der CT-Aufnahmen

Die dreidimensionale Ausrichtung der CT-Aufnahmen wurde ursprünglich

realisiert, indem die Aufnahmen von den Gelenken aus einer horizontalen, einer

sagittalen und einer frontalen Ansicht betrachtet  wurden, jeweils die Winkel

zwischen den landmarks und der Horizontalen bzw. der Vertikalen gemessen

und drei entsprechende Rotationen um die x-, y- und z-Achse durchgeführt

wurden.
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Es folgt eine detaillierte Anleitung für den Umgang mit der verwendeten

Software ImageJ [58]. Die Anleitung beinhaltet das Vorgehen zum korrekten

Setzten der landmarks, zur Durchführung der notwendigen Rotationen und zur

verwendeten Nomenklatur des Dateisystems.

1. ImageJ starten und dann eine  Patienten-Datei mit der Endung .zip, z.B.

mustermann_m.zip, öffnen (File → Open).

2. Oben links im Stack-Fenster steht die Slice-Nr und die Anzahl der Slices,

z. B. 1/125. Die erste Schicht sollte oben im Schädel liegen, so dass wir

von oben nach unten scrollen. Wenn das nicht der Fall ist, dann muss

der Stack umsortiert werden (Plugins →  Stack Reverser). Die

Änderungen sollten abgespeichert werden (File →  Save as →  ZIP).

Dazu muss die alte Datei überschrieben werden (Replace).

3. Als nächstes müssen die Einstellungen des Stacks überprüft werden

(Image →  Properties). Unit of Length muss immer in Millimetern

angegeben sein. Pixel/Unit und Slice Spacing können aus dem Info-file

entnommen werden.

Abbildung 2.12: ImageJ: Properties

4. Properties mit OK verlassen.

5. Mit dem Fenster-Schieber durch die Schichten scrollen und den Gelenk-

Bereich aufsuchen. Alternativ zum Schieber funktionieren auch die

Tasten „Punkt“ und „Komma“. Mit dem linken Gelenk beginnen. Alle

kommenden Ausführungen beziehen sich auf das linke Gelenk. Beim

rechten Gelenk bitte entsprechend umdenken!
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6. Mit dem Rectangular Selection Tool das linke Gelenk sehr großzügig

markieren, so dass Teile des Ohres miterfasst sind. Die Größe des

ausgewählten Bereichs wird bestimmt, indem man den weißen Punkt auf

der gelben Markierung mit der Maus fasst, und durch Bewegungen mit

der Maus die Größe verändert. Durch Drücken der Shift-Taste verändert

sich die gelbe Markierung von einem Rechteck zu einem Quadrat. Die

Größe des ausgewählten Bereichs wird auf dem ImageJ Toolbar

angezeigt. Nun das Zentrum des Quadrates in den Mittelpunkt des

Condylus legen.

Abbildung 2.13: ImageJ: Rectangular Tool zur Auswahl des interessierenden

Bereichs.

7. Das Bild wird auf die ausgewählte Größe zurechtgeschnitten (Image →

Crop).

8. Die Änderungen abspeichern (File → Save as → ZIP). Es wird jetzt die

Endung „_ k g l “ für „Kiefergelenk links“ angehängt. Aus

mustermann_m.zip wird jetzt mustermann_m_kgl.zip.

9. Die landmarks aufsuchen und mit dem Crosshair Tool mit Punkten

markieren. Hierbei streng nach dem vorgegebenem Protokoll mit den

landmark-Definitionen  und immer in der Reihenfolge MAE, SOS, TAA,

OTL vorgehen. Es empfiehlt sich, das Bild mit der Lupe zu vergrößern.
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Abbildung 2.14: Lage der vier Kiefergelenk-landmarks in verschiedenen

Schichtebenen.

Wenn man den ersten Punkt setzt geht ein Results Fenster auf, in dem

die Koordinaten angezeigt werden. Wichtig zu wissen ist, dass die

Punkte nicht gelöscht werden können. Das heißt, wenn ein Fehler

auftritt, muss von vorne begonnen werden. Dazu bitte das File schließen

(Klick auf roten Punkt, Don’t save), das Results Fenster schließen (Don’t

save) und erneut laden (File → Open →  mustermann_m_kgl.zip).

10. Nachdem alle Punkte gesetzt sind, muss der Stack abgespeichert

werden (File→ Save as → ZIP). Es wird jetzt die Endung „p“ für „Punkte“

angehängt.  Aus m u s t e r m a n n _ m _ k g l . z i p  wird jetzt

mustermann_m_kglp.zip.

11. In das Results Fenster klicken und die Daten als txt-file mit dem Namen

mustermann_m_kglp.txt abspeichern (File → Save as → TXT).

12. Das Results Fenster schließen (Klick auf roten Punkt).

13. Das Angle Tool anklicken und den unteren weißen Punkt auf MAE und

den ersten oberen Punkt auf TAA setzen. Den zweiten oberen Punkt so

ausrichten, dass eine vertikale Linie entsteht. Man kann mit den Tasten

Punkt und Komma durch die Slices scrollen, ohne dass das Dreieck

verschwindet. So kann man die weißen Enden auf die Punkte setzen.
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Abbildung 2.15: ImageJ: Angle Tool zur Messung des Winkels für die Rotation um

die z-Achse.

14. Jetzt den Winkel zwischen den Schenkeln vermessen (Analyze →

Measure) . Es erscheint ein Results Fenster. Den Winkelwert zur

Sicherheit notieren. Auf den Stack klicken, um die Menüs wieder

erscheinen zu lassen.

15. Jetzt wird die erste Rotation durchgeführt (Image →  Rotate →

Arbitrarily, Process Stack → Yes). Den eben gemessenen Winkelwert

aus dem Results Fenster eintragen (CAVE: Eingabe mit Punkt statt

Komma, CAVE: wenn der Winkel nach rechts oben offen ist, dann muss

vor dem Wert ein Minuszeichen eingegeben werden. Immer überlegen

wie gedreht werden soll: Linksdrehung [-], Rechtsdrehung [+]),

Interpolate muss abgehakt sein. Mit OK bestätigen. Der Stack wird um

die z-Achse gedreht.

16. MAE und TAA müssen jetzt auf einer vertikalen Linie stehen. Falls jetzt

etwas schief gelaufen ist, bitte das aktuelle (gedrehte) Fenster schließen

(Klick auf roten Punkt, Don’t save) und nochmals zu dem File

mustermann_m_kglp.zip zurückkehren. Notfalls das File erneut laden

(File → Open). Wieder mit Punkt 13 beginnen.
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Abbildung 2.16: ImageJ: Reslice

17. Den gedrehten Stack jetzt umrechnen, so dass eine laterale Ansicht

entsteht (Image →  Stacks →  Reslice). Hierbei muss Input Slice

Spacing identisch mit der Angabe in den Properties sein. Bei Output

tragen wir jetzt 0.5 ein (CAVE: Punkt statt Komma). Start at Left

einstellen (Beim rechtem Gelenk umdenken, also Start at Right). Mit OK

bestätigen. Der Stack wird reformatiert. Man erhält eine Ansicht von

links. MAE und TAA liegen in der selben Schichtebene. Durch den

neuen Stack scrollen und orientieren.

Abbildung 2.17: Ansicht des linken Kiefergelenks von lateral.

18. Auf die Lupe und dann ins Bild klicken um die Ansicht zu vergrößern.

19. Jetzt wie unter Punkt 6 mit dem Rectangular Selection Tool den

interessierenden Bereich auswählen.
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20. Den Stack zurechtschneiden (Image → Crop).

21. Die Änderungen wieder speichern (File → Save as → ZIP). Es wird jetzt

die Endung „r1“ für „Reslice 1“ angehängt. Aus mustermann_m_kglp.zip

wird jetzt mustermann_m_kglpr1.zip.

22. Mit der Lupe vergrößern und Punkt MAE aufsuchen.

23. Das Angle Tool anklicken und den hinteren weißen Punkt auf MAE und

den ersten vorderen Punkt auf TAA setzen. Den zweiten vorderen Punkt

so ausrichten, dass eine horizontale Linie entsteht. Man kann mit den

Tasten Punkt und Komma durch die Slices scrollen, ohne dass das

Dreieck verschwindet. So kann man die weißen Enden auf die Punkte

setzen.

Abbildung 2.18: ImageJ: Angle Tool zur Messung des Winkels für die Rotation um

die x-Achse.

24. Jetzt den Winkel zwischen den Schenkeln vermessen (Analyze →

Measure) . Es erscheint ein Results Fenster. Den Winkelwert zur

Sicherheit notieren. Auf den Stack klicken, um die Menüs wieder

erscheinen zu lassen.

25. Jetzt wird die zweite Rotation durchgeführt (Image →  Rotate →

Arbitrarily, Process Stack → Yes). Den eben gemessenen Winkelwert

aus dem Results Fenster eintragen (CAVE: Eingabe mit Punkt statt

Komma, CAVE: wenn der Winkel nach links oben offen ist, dann muss

vor dem Wert ein Minuszeichen eingegeben werden. Immer überlegen

wie gedreht werden soll: Linksdrehung [-], Rechtsdrehung [+]),

Interpolate muss abgehakt sein. Mit OK bestätigen. Der Stack wird um

die x-Achse gedreht.

26. MAE und TAA müssen jetzt auf einer horizontalen Linie stehen. Falls

jetzt etwas schief gelaufen ist, bitte das aktuelle (gedrehte) Fenster
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schließen (Klick auf roten Punkt, Don’t save) und nochmals zu dem File

mustermann_m_kglp.zip zurückkehren. Notfalls das File erneut laden

(File → Open). Wieder mit Punkt 22 beginnen.

27. Jetzt wieder den Stack umrechnen, so dass eine anteriore Ansicht

entsteht (Image → Stacks → Reslice) anklicken. Input und Output Slice

Spacing muss jetzt auf 0.5 stehen. Start at Left einstellen (beim rechten

Gelenk Start at Left + Rotate 90 Degrees). Mit OK bestätigen.

Abbildung 2.19: ImageJ: Reslice

Der Stack wird reformatiert. Man erhält eine Ansicht von vorne. Achtung,

durch den neuen Stack scrollen und orientieren! Der Stack liegt jetzt

horizontal. Das Ohr ist jetzt oben. Wir können den Stack jetzt zur

besseren Orientierung drehen (Image → Rotate → Rotate 90 degrees

right). Beim rechten Gelenk nicht mehr drehen!
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Abbildung 2.20: Ansicht des linken Kiefergelenks von anterior.

TAA und MEA liegen jetzt zwar in verschiedenen Schichtebenen, aber

auf den selben x- und y-Koordinaten.

28. Nun zur Sicherheit wieder speichern (File → Save as → ZIP). Es wird

jetzt die Endung „r 2 “ für „Reslice 2“ angehängt. Aus

mustermann_m_kglpr1.zip wird jetzt mustermann_m_kglpr1r2.zip. Um

etwas mehr Speicher zu erhalten, können alle anderen noch offenen

Stacks (bis auf mustermann_m_kglpr1r2 und die ImageJ Toolbar)

geschlossen werden.

29. Stack wieder mit der Lupe vergrößern.

30. SOS (medial) und TAA (lateral) aufsuchen.

31. Erneut das Angle Tool benutzen, wie unter Punkt 23. Zwei Punkte liegen

jetzt auf TAA  und SOS , der andere Schenkel bildet wieder eine

Horizontale. CAVE: TAA nicht mit OTL verwechseln. Man kann mit den

Tasten Punkt und Komma durch die Slices hin und her scrollen, ohne

dass das Dreieck verschwindet. So kann man die weißen Enden auf die

Punkte setzen.

Abbildung 2.21: ImageJ: Angle Tool zur Messung des Winkels für die Rotation um

die y-Achse.
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32. Jetzt den Winkel zwischen den Schenkeln vermessen (Analyze →

Measure) . Es erscheint ein Results Fenster. Den Winkelwert zur

Sicherheit notieren. Auf den Stack klicken, um die Menüs wieder

erscheinen zu lassen.

33. Jetzt wird die dritte Rotation durchgeführt (Image →  Rotate →

Arbitrarily, Process Stack → Yes). Den eben gemessenen Winkelwert

aus dem Results Fenster eintragen (CAVE: Eingabe mit Punkt statt

Komma, CAVE: wenn der Winkel nach links oben offen ist, dann muss

vor dem Wert ein Minuszeichen eingegeben werden. Immer überlegen

wie gedreht werden soll: Linksdrehung [-], Rechtsdrehung [+]),

Interpolate muss abgehakt sein. Mit OK bestätigen. Der Stack wird um

die y-Achse gedreht.

34. TAA, SOS, und MAE müssen jetzt auf einer horizontalen Linie sein.

35. Wir können den Stack erneut mit dem Rectangular Selection Tool

beschneiden. Dazu dass Rechteck wieder auf den Mittelpunkt des

Condylus ausrichten (Image → Crop).

36. Jetzt wieder den Stack umrechnen, so dass wieder eine Aufsicht wie zu

Beginn entsteht (Image →  Stacks →  Reslice). Slice Spacing muss

wieder 0.5 sein. Jetzt Start at TOP einstellen. Mit OK bestätigen. Der

Stack wird reformatiert. Die Ansicht ist jetzt wie zu Anfang, nur kann das

Ohr jetzt rechts sein (durch Scrollen orientieren). Beim rechten Gelenk

gilt dies auch.

37. Um dieses zu korrigieren kann der Stack rotiert werden (Image →

Rotate → Flip Horizontally).

38. Das linke Kiefergelenk ist jetzt korrekt ausgerichtet, das heißt MAE

(Meatus acusticus externus), TAA (Tuberculum articulare anterior) und

SOS (Spina ossis sphenoidalis)  liegen jetzt alle in einer Schichtebene.



Material und Methode

57

Abbildung 2.22: Alle drei landmarks sind in die gleiche Schichtebene rotiert.

39. Zum Schluss muss der ausgerichtete Stack noch gespeichert werden

(File → Save as → ZIP). Es wird noch die Endung „r3“ für „Reslice3“

angehängt .  Aus  mustermann_m_kg lp r1 r2 .z ip  wird also

mustermann_m_kglpr1r2r3.zip.

Es müssten in dem Ordner mustermann_m folgende 8 Files sein:

mustermann_mkgl.zip linkes Gelenk zugeschnitten

mustermann_mkglp.txt Koordinaten der gesetzten Punkte

mustermann_mkglp.zip linkes Gelenk mit Punkten

mustermann_mkglpr1.zip linkes Gelenk nach Rotation um

z-Achse

mustermann_mkglpr1r2.zip linkes Gelenk nach Rotation um

x-Achse

mustermann_mkglpr1r2r3.zip linkes Gelenk nach Rotation um

y-Achse

mustermann_m.zip Originaldatensatz

Info for filename.txt Info-Text eines Original DICOM- Bildes

des Patienten; f i l ename  kann

irgendetwas kryptisches sein

40. bei der Reformatierung des rechten Kiefergelenks analog verfahren.
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2.2.2 Mathematische Berechnung der Rotationswinkel

Das oben beschriebene manuelle Ausrichten der Landmarks in eine Ebene ist

sehr zeitintensiv. Konnten wir die benötigte Zeit pro Gelenk letztendlich mit sehr

viel Übung im Umgang mit Image Java auf durchschnittlich etwa sieben

Minuten verkürzen, so muss der Ungeübte doch mindestens die doppelte bis

dreifache Zeit investieren. Hieraus entstand die Idee, die notwendigen

Rotationswinkel und Rotationsrichtungen auf mathematischem Wege zu

bestimmen.

Wenn die anatomischen Landmarks im Programm Image Java festgelegt

werden, teilt das Programm die Koordinaten eines jeden Punktes mit. Für jeden

Punkt wird ein Wert für die x-, y- und z-Achse eines dreidimensionalen

Koordinatensystems angegeben. Dieser Datensatz reicht aus, um die

notwendigen Informationen zu berechnen.

2.2.2.1 Geometrisches Prinzip und mathematische Grundlagen

Die geometrische Idee hinter der weiter unten stehenden Berechnung ist

folgende: Wie in Abbildung 2.23 gezeigt, spannen drei Punkte im

dreidimensionalen Raum immer eine Ebene auf.
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Abbildung 2.23: Zwischen drei Punkten im dreidimensionalen Raum wird eine Ebene

aufgespannt.

Das Ziel der Rotation ist es, diese Ebene parallel zur Aufsichtsebene, die der

xy-Ebene des Koordinatensystems entspricht, auszurichten. Auf

mathematischem Weg wird hierzu der Normalenvektor zu dieser Ebene

berechnet. Der Normalenvektor steht, wie in Abbildung 2.24 zu sehen ist,

senkrecht zu den beiden Richtungsvektoren seiner Ebene.
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Abbildung 2.24: Der Normalenvektor steht senkrecht auf der Ebene. Zu jeder Ebene gibt

es zwei Normalenvektoren.

Um nun die aufgespannte Ebene parallel zur xy-Ebene auszurichten, muss der

Normalenvektor parallel zur z-Achse ausgerichtet werden.

Zunächst soll auf die notwendigen mathematischen Schritte etwas näher

eingegangen werden:

Als erstes muss aus den Koordinaten der Landmarks die aufgespannte Ebene

berechnet werden. Eine Ebene setzt sich zusammen aus einem Stützvektor

und zwei Richtungsvektoren. Gegeben sind die drei Punkte mit folgenden

Koordinaten:

A (a/b/c)

B (d/e/f)

C (g/h/i)

Die Ebene   

€ 

r x , in der die drei Punkte liegen, berechnet sich in diesem allgemein

gehaltenen Fall wie folgt:
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 

 

 
  

+ k
d − a
e − b
f − c

 

 

 
  

 

 

 
  

+ l
g − a
h − b
i − c

 

 

 
  

 

 

 
  

Der zweite mathematische Schritt ist, den Normalenvektor   

€ 

r n  zu berechnen. Der

Normalenvektor hat die Eigenschaft, senkrecht zu seiner Ebene, das heißt zu

den beiden Richtungsvektoren der Ebene, zu verlaufen. Der Normalenvektor

entsteht aus dem Kreuzprodukt der beiden Richtungsvektoren. Zur Anwendung

des Kreuzproduktes folgt nun eine kurze Erläuterung.

€ 

m
n
o

 

 

 
  

 

 

 
  
×

p
q
r

 

 

 
  

 

 

 
  

=

nr − oq
op −mr
mq − np

 

 

 
  

 

 

 
  

Zur Veranschaulichung folgt noch ein Zahlenbeispiel:

€ 

2
1
3

 

 

 
  

 

 

 
  
×

1
2
1

 

 

 
  

 

 

 
  

=

−5
1
3

 

 

 
  

 

 

 
  

Probe: Da der Kosinus von 90° gleich null ist, ist auch das Produkt zweier

senkrechter Vektoren gleich null.

€ 

2
1
3

 

 

 
  

 

 

 
  
∗

−5
1
3

 

 

 
  

 

 

 
  

= −10+1+ 9 = 0

1
2
1

 

 

 
  

 

 

 
  
∗

−5
1
3

 

 

 
  

 

 

 
  

= −5+ 2 + 3 = 0

Damit ist bewiesen, dass der Normalenvektor senkrecht zu den beiden

Vektoren steht.
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Der abschließende mathematische Schritt ist, die Rotationswinkel zu

berechnen. Hierbei findet das Skalarprodukt seine Anwendung. Es gilt, dass

das Skalarprodukt zweier Vektoren gleich dem Produkt aus den Längen der

Vektoren und dem Kosinus des Winkels zwischen den Vektoren ist. Auch zur

Winkelberechnung im dreidimensionalen Raum eine kurze Erläuterung:

  

€ 

r s ∗ r v = r s ∗ r v ∗cosγ

s
t
u

 

 

 
  

 

 

 
  
∗

v
w
x

 

 

 
  

 

 

 
  

=

s
t
u

 

 

 
  

 

 

 
  
∗

v
w
x

 

 

 
  

 

 

 
  
∗cosγ

sv + tw + ux = s2 + t 2 + u2 ∗ v 2 + w2 + x 2 ∗cosγ

cosγ =
sv + tw + ux

s2 + t 2 + u2 ∗ v 2 + w2 + x 2

γ =
180°
π

∗arccos sv + tw + ux
s2 + t 2 + u2 ∗ v 2 + w2 + x 2

Auch hierzu zwei Zahlenbeispiele, in denen die Winkel zwischen den Vektoren

in der Abbildung 2.25 berechnet werden.

Abbildung 2.25: Zahlenbeispiele zur Berechnung von Winkeln zwischen zwei Vektoren

€ 

1
0
0

 

 

 
  

 

 

 
  
∗

0
1
0

 

 

 
  

 

 

 
  

=

1
0
0

 

 

 
  

 

 

 
  
∗

0
1
0

 

 

 
  

 

 

 
  
∗cosγ

0 = 12 ∗ 12 ∗cosγ
0 =1∗1∗cosγ
cosγ = 0
γ = 90°

€ 

1
0
0

 

 

 
  

 

 

 
  
∗

1
1
0

 

 

 
  

 

 

 
  

=

1
0
0

 

 

 
  

 

 

 
  
∗

1
1
0

 

 

 
  

 

 

 
  
∗cosγ

1= 12 ∗ 12 +12 ∗cosγ
1=1∗ 2 ∗cosγ

cosγ =
1
2

γ = 45°
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Um den Normalenvektor   

€ 

r n  parallel zur z-Achse auszurichten, sind zwei

Rotationen notwendig. Die erste Rotation wird um die x-Achse um den Winkel α

durchgeführt, die zweite um die y-Achse um den Winkel β, der sich aus Winkel

β´ interpretieren lässt. Um den Rotationswinkel α zu berechnen, muss eine

zweidimensionale Projektion des Normalenvektors   

€ 

r n  betrachtet werden. Der

Winkel α liegt zwischen der Projektion von   

€ 

r n  in der yz-Ebene und der z-Achse.

Der Winkel β´ liegt zwischen dem Normalenvektor und der x-Achse im

dreidimensionalen Raum.

Die Betrachtung eines dreidimensionalen Falls als zweidimensionale Projektion

funktioniert wie in den folgenden Beispielen demonstriert:

Es soll der Winkel zwischen dem exemplarischen Vektor   

€ 

r p  und der z-Achse in

der yz-Ebene berechnet werden. Dazu wird der Vektor   

€ 

r z , der parallel zur z-

Achse ist, gebildet.

  

€ 

r z =
0
0
1

 

 

 
  

 

 

 
  

r p =
p
q
r

 

 

 
  

 

 

 
  

in 2D in der yz-Ebene 

€ 

⇒
0
1
 

 
 
 

 
 

⇒
q
r
 

 
 
 

 
 

€ 

0
1
 

 
 
 

 
 ∗

q
r
 

 
 
 

 
 =1∗ q2 + r2 ∗cosγ

cosγ =
r

q2 + r2

γ =
180°
π

∗arccos r
q2 + r2

Auch hierzu folgt ein kurzes Zahlenbeispiel, indem für Vektor   

€ 

r p  untenstehende

Zahlenwerte verwendet werden.
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€ 

r z =
0
0
1

 

 

 
  

 

 

 
  

r p =
1
1
0

 

 

 
  

 

 

 
  

in 2D in der yz-Ebene 

€ 

⇒
0
1
 

 
 
 

 
 

⇒
1
0
 

 
 
 

 
 

€ 

0
1
 

 
 
 

 
 ∗
1
0
 

 
 
 

 
 =1∗1∗cosγ

cosγ = 0
γ = 90°

2.2.2.2 Allgemeine Formel zur Berechnung der Rotationswinkel

Soviel zur Theorie. Im Folgenden wird wieder die eigentliche Fragestellung

betrachtet. Die Rotationswinkel sollen einmal allgemein berechnet werden, so

dass in Zukunft nur noch die Zahlenwerte der Koordinaten der Landmarks in

das Endergebnis eingesetzt werden müssen, um die gesuchten Winkel zu

bestimmen. Hierbei spielt es keine Rolle, welchen der drei Landmarks (MAE,

SOS und TAA) man als Punkt A, B, oder C betrachtet.

Gegeben sind also drei Punkte mit folgenden Koordinaten:

A (a/b/c)

B (d/e/f)

C (g/h/i)

Die Ebene   

€ 

r x , in der die drei Punkte liegen, berechnet sich wie folgt:

  

€ 

r x =
a
b
c

 

 

 
  

 

 

 
  

+ k
d − a
e − b
f − c

 

 

 
  

 

 

 
  

+ l
g − a
h − b
i − c

 

 

 
  

 

 

 
  
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Der hieraus resultierende Normalenvektor   

€ 

r n  errechnet sich durch das

Kreuzprodukt der Richtungsvektoren der Ebene   

€ 

r x :

  

€ 

r n =
d − a
e − b
f − c

 

 

 
  

 

 

 
  
×

g − a
h − b
i − c

 

 

 
  

 

 

 
  

r n =
(e − b)(i − c) − (h − b)( f − c)
(g − a)( f − c) − (i − c)(d − a)
(d − a)(h − b) − (e − b)(g − a)

 

 

 
  

 

 

 
  

r n =
ei − ce − bi + bc − fh + ch + bf − bc
fg − cg− af + ac − di + ai + cd − ac
dh − bd − ah + ab − eg + ae + bg − ab

 

 

 
  

 

 

 
  

r n =
ei − ce − bi − fh + ch + bf
fg − cg− af − di + ai + cd
dh − bd − ah − eg + ae + bg

 

 

 
  

 

 

 
  

Der Normalenvektor   

€ 

r n  ist senkrecht zur Ebene   

€ 

r x . Allerdings bestehen zu jeder

Ebene zwei Normalenvektoren, die in entgegengesetzte Richtungen verlaufen,

wie in Abbildung 2.24 zu erkennen ist. Dieser Umstand macht eine Betrachtung

der Verlaufsrichtung des errechneten Normalenvektors nötig:

Ein dreidimensionales Koordinatensystem lässt sich wie in Abbildung 2.26

gezeigt in acht Oktanten aufteilen. Eine Besonderheit bei dem von Image Java

über die CT-Datensätze gelegten Koordinatensystem ist die von oben nach

unten verlaufende y-Achse.
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Abbildung 2.26: Unterteilung eines Koordinatensystems in Oktanten.

Um die Richtung des Normalenvektors   

€ 

r n  zu bestimmen wird ein zu   

€ 

r n  paralleler

Vektor, dessen Beginn am Nullpunkt des Koordinatensystems liegt, betrachtet.

Entscheidend ist nun, in welchen der acht Oktanten dieser Vektor vom

Nullpunkt aus verläuft. Dieses kann anhand der Vorzeichen des

Normalenvektors   

€ 

r n  bestimmt werden, wie in Tabelle 2.2 gezeigt.

Tabelle 2.2: Richtungsbestimmung des Normalenvektors.

Normalenvektor n
X + + - - + + - -
Y + - + - + - + -
Z + + + + - - - -

Oktant I II III IV V VI VII VIII

Verläuft dieser Vektor in die Richtung eines der Oktanten V-VIII entsteht ein

Winkel α zwischen der Projektion von   

€ 

r n  in der yz-Ebene und der z-Achse, der

größer ist als 90°. In diesem Falle käme zu der Rotation der Abbildung des

IV

VIII

II

VI

I

III

VII

V

Y

Z

X



Material und Methode

67

Kiefergelenks auch eine ungewollte Spiegelung hinzu. Aus diesem Grunde

muss der Normalenvektor   

€ 

r n  betrachtet werden. Das heißt, wenn der  Wert für

die z-Koordinate negativ ist, müssen alle drei Vorzeichen des Normalenvektors

verändert werden. Auf diese Weise erhält man den zweiten Normalenvektor der

von den Landmarks aufgespannten Ebene. Ein zu diesem Normalenvektor   

€ 

r n 

paralleler Vektor, dessen Beginn am Nullpunkt des Koordinatensystems liegt,

verläuft in einen der Oktanten I-IV. Somit ist der Winkel α kleiner als 90°, und

die ungewollte Spiegelung lässt sich vermeiden.

Um die Ebene   

€ 

r x  parallel zur xy-Ebene, also der Betrachtungsebene,

auszurichten, muss der Normalenvektor   

€ 

r n  parallel zur z-Achse ausgerichtet

werden. Hierzu sind zwei Rotationen notwendig. Die erste Rotation wird um die

x-Achse um den Winkel α durchgeführt, die zweite um die y-Achse um den

Winkel β . Um den Rotationswinkel α  zu berechnen, muss eine

zweidimensionale  Projektion des Normalenvektors   

€ 

r n  betrachtet werden. Der

Winkel α liegt zwischen der Projektion von   

€ 

r n  in der yz-Ebene und der z-Achse,

der Winkel β ist erst nach einer Interpretation des Winkels β´ zu benennen,

welcher zwischen dem Normalenvektor   

€ 

r n  und der x-Achse im

dreidimensionalen Raum liegt. Um die Winkel zu berechnen bedient man sich

des Wissens, dass das Skalarprodukt zweier Vektoren gleich dem Produkt ihrer

Längen und dem Kosinus des eingeschlossenen Winkels ist.

In diesem Fall wird der Rotationswinkel α wie folgt berechnet:

  

€ 

r z =
0
0
1

 

 

 
  

 

 

 
  

r n =
ei − ce − bi − fh + ch + bf
fg − cg− af − di + ai + cd
dh − bd − ah − eg + ae + bg

 

 

 
  

 

 

 
  

in 2D in yz-Ebene: 

€ 

⇒
0
1
 

 
 
 

 
 

⇒
fg − cg− af − di + ai + cd
dh − bd − ah − eg + ae + bg
 

 
 

 

 
 

€ 

0
1
 

 
 
 

 
 ∗

fg− cg− af − di + ai + cd
dh − bd − ah − eg+ ae + bg
 

 
 

 

 
 =1∗ fg− cg − af − di + ai + cd( )2 + dh − bd − ah − eg + ae + bg( )2 ∗cosα
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€ 

cosα =
dh − bd − ah − eg + ae + bg

fg− cg − af − di + ai + cd( )2 + dh − bd − ah − eg + ae + bg( )2

α =
180°
π

∗arccos dh − bd − ah − eg+ ae + bg
fg − cg− af − di + ai + cd( )2 + dh − bd − ah − eg+ ae + bg( )2

Anschließend noch die Berechnung des Winkels β´:

  

€ 

r x =
1
0
0

 

 

 
  

 

 

 
  

r n =
ei − ce − bi − fh + ch + bf
fg − cg− af − di + ai + cd
dh − bd − ah − eg + ae + bg

 

 

 
  

 

 

 
  

€ 

1
0
0

 

 

 
  

 

 

 
  
∗

ei − ce − bi − fh + ch + bf
fg− cg− af − di + ai + cd
dh − bd − ah − eg+ ae + bg

 

 

 
  

 

 

 
  

=1∗ ei − ce − bi − fh + ch + bf( )2 + fg− cg− af − di + ai + cd( )2 + dh − bd − ah − eg+ ae + bg( )2 ∗cosβ′

€ 

cosβ′ = ei − ce − bi − fh + ch + bf
ei − ce − bi − fh + ch + bf( )2 + fg − cg− af − di + ai + cd( )2 + dh − bd − ah − eg+ ae + bg( )2

β′ =
180°
π

∗arccos ei − ce − bi − fh + ch + bf
ei − ce − bi − fh + ch + bf( )2 + fg− cg− af − di + ai + cd( )2 + dh − bd − ah − eg+ ae + bg( )2

Um Winkel β zu erhalten, muss folgende Berechnung angestellt werden:

€ 

β = 90°−β′( )∗ −1( )

Die Multiplikation mit dem Faktor –1 ist nötig, da eine Rotation um einen

positiven Winkel nach mathematischer Definition gegen den Uhrzeigersinn und

um einen negativen Winkel im Uhrzeigersinn durchgeführt werden muss. Im

Gegensatz dazu definiert ImageJava die Rotationsrichtungen genau

andersherum.
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2.2.2.3 Bestimmung der Rotationsrichtung

Nach dem Errechnen der Rotationswinkel bleibt noch die Frage nach der

Rotationsrichtung. Die Rotationsrichtung wird von ImageJava definiert als „im

Uhrzeigersinn“ (cw) und „gegen den Uhrzeigersinn“ (ccw), vom Nullpunkt des

Koordinatensystems aus in Verlaufsrichtung der Rotationsachsen, also der x-

bzw. der y-Achse, betrachtet. Eine Rotation um einen positiven Winkel wird im

Uhrzeigersinn, um einen negativen Winkel gegen den Uhrzeigersinn

ausgeführt.

Die Richtung der ersten Rotation um die x-Achse ist abhängig von der Richtung

des Normalenvektors   

€ 

r n . Verläuft die Nullpunktparallele des Normalenvektors   

€ 

r n 

in einen der Quadranten I oder III, so muss die Rotation im Uhrzeigersinn

erfolgen. Verläuft die Nullpunktparallele des Normalenvektors   

€ 

r n  in einen der

Quadranten II oder IV, so muss gegen den Uhrzeigersinn rotiert werden.

Auch die zweite Rotation ist abhängig von der Richtung des Normalenvektors.

Erhält man für Winkel β einen positiven Wert, so verläuft die Nullpunktparallele

des Normalenvektors   

€ 

r n  in einen der Quadranten III oder IV, und die Rotation

um die y-Achse muss im Uhrzeigersinn vorgenommen werden. Hat Winkel β

einen negativen Wert, verläuft die Nullpunktparallele des Normalenvektors   

€ 

r n  in

einen der Quadranten I oder II, und es muss gegen den Uhrzeigersinn rotiert

werden.

In Tabelle 2.3 sind die Rotationsrichtungen und Rotationswinkel für alle vier

denkbaren Fälle zusammengefasst. Die Berechnung des Winkels β liefert je

nach Vorzeichen des Ergebnisses auch schon die nötigen Informationen über

die Rotationsrichtung. Bei der Berechnung des Winkels α erhält man immer ein

positives Ergebnis, was eine Betrachtung der Verlaufsrichtung des

Normalenvektors wie in Tabelle 2.2, und eine Festlegung der Rotationsrichtung

wie in Tabelle 2.3 gezeigt, nötig macht.
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Tabelle 2.3: Rotationswinkel und Rotationsrichtung.

Oktant Rotation Richtung Winkel

I 1. cw α
2. ccw β

II 1. ccw  −α
2. ccw β

III 1. cw  α
2. cw β

IV 1. ccw  −α
2. cw β

cw clockwise
ccw counterclockwise
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2.2.3 Plugin „TMJ_Rotation“

Unter Zuhilfenahme der oben berechneten Formeln wurde mit SubEthaEdit®

[83] ein Plugin mit dem Namen „TMJ_Rotation“ für ImageJava geschrieben. Mit

Hilfe dieses Unterprogramms kann die räumliche Ausrichtung der CT-

Aufnahmen zeitsparend und anwenderfreundlich durchgeführt werden. Der

User wird nur noch aufgefordert, die Koordinaten der landmarks einzugeben

und die interessierenden Schichten, in denen das Kiefergelenk liegt,

anzugeben. Als Resultat wird der Normalenvektor   

€ 

r n  und die beiden relevanten

Rotationswinkel errechnet und die Rotationsrichtungen werden bestimmt. Das

Plugin liest aus dem ursprünglichen Stack die Schichtdicke aus und führt auf

Grundlage dieses Datensatzes die notwendigen Rotationen durch.

Es folgt eine detaillierte Anleitung für den Umgang mit der Auswertungssoftware

ImageJ unter Verwendung des TMJ_Rotation-Plugin. Die Anleitung beinhaltet

das Vorgehen zum korrekten Setzten der landmarks, zur Berechnung und

Durchführung der notwendigen Rotationen und zur verwendeten Nomenklatur

des Dateisystems. Der Sourcecode des Plugins findet sich im Anhang ab

Seite I.

1. ImageJ starten und dann eine  Patienten-Datei mit der Endung .zip, z.B.

mustermann_m.zip, öffnen (File → Open).

2. Oben links im Stack-Fenster steht die Slice-Nr und die Anzahl der Slices,

z. B. 1/125. Die erste Schicht sollte oben im Schädel liegen, so dass wir

von oben nach unten scrollen. Wenn das nicht der Fall ist, dann muss

der Stack umsortiert werden (Plugins →  Stack Reverser). Die

Änderungen sollten abgespeichert werden (File →  Save as →  ZIP).

Dazu muss die alte Datei überschrieben werden (Replace).

3. Als nächstes müssen die Einstellungen des Stacks überprüft werden

(Image →  Properties). Unit of Length muss immer in Millimetern
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angegeben sein. Pixel/Unit und Slice Spacing können aus dem Info-file

entnommen werden.

Abbildung 2.27: ImageJ: Properties

4. Properties mit OK verlassen.

5. Mit dem Fenster-Schieber durch die Schichten scrollen und den Gelenk-

Bereich aufsuchen. Alternativ zum Schieber funktionieren auch die

Tasten „Punkt“ und „Komma“. Mit dem linken Gelenk beginnen.

6. Mit dem Rectangular Selection Tool das linke Gelenk sehr großzügig

markieren, so dass Teile des Ohres miterfasst sind. Die Größe des

ausgewählten Bereichs wird bestimmt, indem man den weißen Punkt auf

der gelben Markierung mit der Maus fasst, und durch Bewegungen mit

der Maus die Größe verändert. Durch Drücken der Shift-Taste verändert

sich die gelbe Markierung von einem Rechteck zu einem Quadrat. Die

Größe des ausgewählten Bereichs wird auf dem ImageJ Toolbar

angezeigt. Nun das Zentrum des Quadrates in den Mittelpunkt des

Condylus legen.
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Abbildung 2.28: ImageJ: Rectangular Tool zur Auswahl des interessierenden

Bereichs

7. Das Bild wird auf die ausgewählte Größe zurechtgeschnitten (Image →

Crop).

8. Die Änderungen abspeichern (File → Save as → ZIP). Es wird jetzt die

Endung „_ k g l “ für „Kiefergelenk links“ angehängt. Aus

mustermann_m.zip wird jetzt mustermann_m_kgl.zip.

9. Die landmarks aufsuchen und mit dem Crosshair Tool mit Punkten

markieren. Hierbei streng nach dem vorgegebenem Protokoll mit den

landmark-Definitionen  und immer in der Reihenfolge MAE, SOS, TAA,

OTL vorgehen. Es empfiehlt sich, das Bild mit der Lupe zu vergrößern.

Abbildung 2.29: Lage der vier Kiefergelenk-landmarks in verschiedenen

Schichtebenen.

Wenn man den ersten Punkt setzt geht ein Results Fenster auf, in dem

die Koordinaten angezeigt werden. Wichtig zu wissen ist, dass die
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Punkte nicht gelöscht werden können. Das heißt, wenn ein Fehler

auftritt, muss von vorne begonnen werden. Dazu bitte das File schließen

(Klick auf roten Punkt, Don’t save), das Results Fenster schließen (Don’t

save) und erneut laden (File → Open →  mustermann_m_kgl.zip).

Abbildung 2.30: ImageJ: Koordinaten der gesetzten landmarks.

10. Nachdem alle Punkte gesetzt sind, muss der Stack abgespeichert

werden (File→ Save as → ZIP). Es wird jetzt die Endung „p“ für „Punkte“

angehängt.  Aus m u s t e r m a n n _ m _ k g l . z i p  wird jetzt

mustermann_m_kglp.zip.

11. In das Results Fenster klicken und die Daten als txt-file mit dem Namen

mustermann_m_kglp.txt abspeichern (File → Save as → TXT).

12. Das Results Fenster schließen (Klick auf roten Punkt).

13. Jetzt das TMJ_Rotation-Plugin starten (Plugins → TMJ_Rotation).
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Abbildung 2.31: ImageJ: Eingabeaufforderung des Plugin

Koordinaten der drei landmarks MAE, SOS und TAA eintragen. Mit OK

bestätigen. Am Ende der gesamten Prozedur erscheint ein

Ergebnisfenster, in dem der Normalenvektor und die beiden

Rotationswinkel angegeben werden. Die Vorzeichen der Winkel

entsprechen den Rotationsrichtungen. Zur Kontrolle werden auch die

zuvor eingetragenen Koordinaten und die aus dem DICOM-Datensatz

ausgelesene Schichtdicke aufgeführt.

Abbildung 2.32: ImageJ: Ergebnisfenster des Plugin
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14. Es wird automatisch das Plugin „Substack Maker“ gestartet. Der

Benutzer wird aufgefordert, die Schichten zu benennen, in denen das

Kiefergelenk abgebildet ist. Alle übrigen Schichten werden entfernt und

das Ergebnis wird als neuer Stack in einem neuen Fenster geöffnet. Es

empfiehlt sich, sowohl nach cranial als auch nach kaudal etwas

Sicherheitsabstand zu belassen.

Abbildung 2.33: Substack Maker: Überflüssige Schichten werden gelöscht

15. Das Plugin liest im Folgenden selbstständig die Schichtdicke aus dem

DICOM-Datensatz aus, berechnet die Rotationswinkel und führt die

Rotationen aus.

16. Die drei landmarks MAE, SOS und T A A liegen jetzt in einer

Schichtebene.

Abbildung 2.34: Das korrekt ausgerichtete linke Kiefergelenk.
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Zum Schluss muss der ausgerichtete Stack noch gespeichert werden

(File →  Save as →  ZIP). Es wird noch die Endung „rot“ für „rotiert“

angehängt. Aus m u s t e r m a n n _ m _ k g l p . z i p  wird also

mustermann_m_kglprot.zip.

Es müssten in dem Ordner mustermann_m folgende 6 Files sein:

mustermann_mkgl.zip linkes Gelenk zugeschnitten

mustermann_mkglp.txt Koordinaten der gesetzten Punkte

mustermann_mkglp.zip linkes Gelenk mit Punkten

mustermann_mkglprot.zip linkes Gelenk korrekt ausgerichtet

mustermann_m.zip Originaldatensatz

Info for filename.txt Info-Text eines Original DICOM- Bildes

des Patienten; filename kann

irgendetwas kryptisches sein

20. bei der Reformatierung des rechten Kiefergelenks exakt identisch

verfahren.

Einen Schritt weiter gedacht wäre die ideale Lösung ein Plugin für Image Java,

das unaufgefordert die Koordinaten schon beim Setzten der Landmarks

registriert und aufgrund dieses Datensatzes die entsprechenden Berechnungen

der Rotationswinkel anstellt, die Verlaufsrichtung des Normalenvektors   

€ 

r n 

analysiert und nach korrekter Feststellung der Rotationsrichtung die beiden

Rotationen durchführt. Der User würde auf diesem Wege sofort ein ideal

ausgerichtetes CT erhalten. Eine derartige Umsetzung der oben aufgeführten

Überlegungen würde eine immense Zeitersparnis bedeuten, insbesondere für

Kollegen, die nicht täglich mit Image Java arbeiten.
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3 Ergebnisse

3.1 Reproduzierbarkeit der landmarks

Der durchschnittliche Fehlerradius für alle neunzehn untersuchten landmarks

lag bei 

€ 

R LM  = 2,04 mm ± 2,20 mm. Allerdings zeigten die interindividuellen

Fehlerradien der einzelnen landmarks eine deutliche Variation. Die beste

interindividuelle Reproduzierbarkeit zeigte der Punkt FI (Foramen incisivum) mit

einem gemessenen Fehlerradius von nur 

€ 

R FI = 0,43 mm ± 0,28 mm. Auf der

anderen Seite wurde bei dem Punkt FL (Fuzzy lambda) mit 

€ 

R FL  = 4,6 mm ±

4,21 mm der größte Fehlerradius gemessen und damit die schlechteste

Reproduzierbarkeit festgestellt (s. Tabelle 3.1 und Abbildung 3.1).

Tabelle 3.1: Ergebnisse aller untersuchten landmarks

180 ,00 11,05 2,3038 2,25435 5,082

180 ,00 11,36 2,5114 2,54290 6,466

180 ,00 6,65 1,1804 1,20128 1,443

180 ,00 5,27 1,2572 ,98377 ,968

180 ,00 6,39 1,5816 1,45016 2,103

180 ,00 11,07 2,1789 1,93444 3,742

180 ,00 20,02 2,7724 3,32691 11,068

180 ,00 7,29 1,6262 1,39090 1,935

180 ,00 5,45 1,3049 ,99184 ,984

180 ,00 6,39 1,1449 1,23735 1,531

180 ,00 8,11 2,3904 1,90355 3,624

180 ,00 7,78 2,4506 1,95834 3,835

180 ,00 7,61 2,2186 1,88596 3,557

180 ,00 7,52 2,1072 1,85088 3,426

180 ,00 7,83 2,2288 1,82204 3,320

180 ,00 7,80 2,2538 1,79786 3,232

180 ,00 13,25 2,2049 2,25033 5,064

180 ,00 21,47 4,5995 4,21191 17,740

180 ,00 ,98 ,4307 ,28379 ,081

mae_l
sos_l
taa_l
otl_l
fc_l
mae_r
sos_r
taa_r
otl_r
fc_r
mo_l
mo_r
lo_l
lo_r
otm_l
otm_r
fs
fl
fi

N Min. Max. Mean
Std.

Deviation Variance
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Bei der Anwendung der einfaktoriellen Varianzanalyse ANOVA zeigte der

Levene-Test, dass ein signifikanter Unterschied in den Varianzen der

landmarks besteht (p < 0,001). Aus diesem Grund wurde als multipler

Gruppenvergleich der Post-Hoc-Test nach Games-Howell gewählt.

Abbildung 3.1: Interindividuelle Fehlerradien aller untersuchten landmarks. Die kleinsten

Radien wurden für den Punkt FI (

€ 

R FI = 0,43 mm ± 0,28 mm), die größten für den Punkt FL

(

€ 

R FL  = 4,59 mm ± 4,21 mm) gemessen.

Von den neunzehn untersuchten landmarks sind sechzehn paarig, das heißt,

sowohl auf der rechten als auch auf der linken Seite zu finden. Die acht

beidseitigen landmark-Paare wurden mit dem t-Test für gepaarte Stichproben

verglichen. Bei sechs der Paare wurde kein signifikanter Unterschied

festgestellt. Die Punkte TAA (Tuberculum articulare anterior; 0,001 < p ≤ 0,01)

mae_l
sos_l
taa_l
otl_l
fc_l

mae_r
sos_r
taa_r
otl_r
fc_r

mo_l
mo_r

lo_l
lo_r

otm_l
otm_r

fs
fl
fi

interindividueller Fehlerradius (mm)
14121086420-2
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und FC (Fuzzy condyle; p≤0,001) zeigten im Seitenvergleich signifikante

Unterschiede.

Da deutliche Unterschiede in der Reproduzierbarkeit der verschiedenen

landmarks bestanden, wurde eine weitere Einteilung der landmarks in Gruppen

verschiedener Regionen (ROIs, regions of interest) vorgenommen (s. Tabelle

2.1, Seite 34). Die Gruppe TMJ beinhaltet die von uns im Bereich der

Kiefergelenke definierten landmarks, die Gruppe Orbital besteht aus landmarks,

die schon 1992 von Waitzmann et al. [83, 85] verwendet wurden und die

Gruppe Fuzzy ist aus neu definierten fuzzy-landmarks zusammengesetzt. Der

Punkt FI (Foramen incisivum) wurde in dieser Einteilung nicht berücksichtigt.

Der t-Test zeigte signifikante Unterschiede im Vergleich der Gruppen TMJ und

Orbital (p=0,00) und im Vergleich der Gruppen TMJ und Fuzzy (p=0,00). Den

geringsten durchschnittlichen Fehlerradius konnte die Gruppe TMJ (

€ 

R TMJ = 1,89

mm ± 2,07 mm) aufweisen, gefolgt von der Gruppe Orbital (

€ 

R Orbital = 2,27 mm ±

1,87 mm) und der Gruppe Fuzzy (

€ 

R Fuzzy  = 2,38 mm ± 2,89 mm) (Abbildung 3.2).

Eine homogene Gruppe von Punkten, die sich durch ihre Fehlerradien nicht

signifikant voneinander unterscheiden, bilden die orbitalen landmarks

(Abbildung 3.3). Innerhalb der Gruppe TMJ finden sich signifikante

Unterschiede zwischen den landmarks. Durch ihre kleineren Fehlerradien

unterscheiden sich die Punkte TAA_L (Tuberculum articulare anterior links),

OTL_L (Os temporale laterale links) und OTL_R (Os temporale laterale rechts)

signifikant (p=0,00) von den übrigen Punkten der Gruppe TMJ. Der Punkt

TAA_R (Tuberculum articulare anterior rechts) unterscheidet sich ebenfalls

(0,01 < p ≤ 0,05) von den übrigen Punkten (Abbildung 3.2). Inhomogene

Ergebnisse wurden für die Gruppe Fuzzy gefunden. Alle landmarks

unterscheiden sich mit höchster Signifikanz (p=0,00), nur der Unterschied der

Punkte FC_L und FC_R (Fuzzy condyle links und rechts) fällt in ein geringeres

Signifikanzniveau (0,01 < p ≤ 0,05). Auffällig in dieser Gruppe ist, dass mit dem

landmark FC_R (Fuzzy condyle rechts, 

€ 

R FC_R  = 1,14 mm ± 1,24 mm) der

landmark mit dem zweitkleinsten Fehlerradius und mit FL (Fuzzy lambda, 

€ 

R FL  =

4,6 mm ± 4,21 mm) der landmark mit dem größten Fehlerradius aller

untersuchten landmarks in diese Gruppe fallen.
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Abbildung 3.2: Gegenüberstellung der verschiedenen landmark-Gruppen. Die

Gruppe TMJ zeigt durchschnittlich die kleinsten Fehlerradien (

€ 

R TMJ = 1,89 mm ±

2,07 mm) und unterscheidet sich signifikant von den Gruppen Orbital und Fuzzy

(p=0,00). RECHTS: Innerhalb der Gruppe TMJ unterscheiden sich die Punkte

TAA_L, OTL_L, TAA_R und OTL_R signifikant durch ihre geringeren Fehlerradien

von den anderen Punkten.

Abbildung 3.3: Die Gruppe Orbital zeigt eine homogene Verteilung der Fehlerradien ohne

signifikante Unterschiede zwischen den einzelnen landmarks. RECHTS: Innerhalb der

Gruppe Fuzzy unterscheiden sich die Ergebnisse aller landmarks voneinander. Mit den

landmarks FC_R (

€ 

R FC_R  = 1,14 mm ± 1,24 mm) und FL (Fuzzy lambda, 

€ 

R FL  = 4,6 mm ±

4,21 mm) fallen der landmark mit dem zweitkleinsten Fehlerradius und der landmark mit

dem größten Fehlerradius in diese Gruppe.
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Bei der Untersuchung des CT-Datensatzes mit der großen Schichtdicke von

vier mm wurde ein durchschnittlicher interindividueller Fehlerradius von

€ 

R LM_4mm  = 3,02 mm ± 4,26 mm für alle neunzehn landmarks gefunden. Damit ist

hier der Durchschnitt der Fehlerradien mit 0,98 mm Differenz um 48% größer

als bei den achtzehn zuvor untersuchten CT-Daten.
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3.2 3D Ausrichtung einer CT-Aufnahme nach der Grundebene

Mit dem von uns programmierten „TMJ_Rotation“-Plugin für ImageJ lassen sich

die CT-Aufnahmen der Kiefergelenke in relativ kurzer Zeit entsprechend der

Lage der die Gelenkgrenzen markierenden landmarks TAA; MAE und SOS

ausrichten.

Im Folgenden sind die Ergebnisse dreier wahllos herausgesuchten

Patientenfälle dargestellt.

3.2.1 1.Patientenfall; weiblich, 53 Jahre

linkes Kiefergelenk:

Abbildung 3.4: Linkes Kiefergelenk; Lage der landmarks in verschiedenen Ebenen
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Abbildung 3.5: Normalenvektor, Rotationswinkel, Kontrollausgabe der landmark-

Koordinaten und Schichtdicke der Aufnahme

Abbildung 3.6: Korrekt ausgerichtetes linkes Kiefergelenk. In diesem Fall liegt zufällig

auch das landmark OTL in derselben Schichtebene.
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rechtes Kiefergelenk:

Abbildung 3.7: Rechtes Kiefergelenk; Lage der landmarks in verschiedenen Ebenen

Abbildung 3.8: Normalenvektor, Rotationswinkel, Kontrollausgabe der landmark-

Koordinaten und Schichtdicke der Aufnahme
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Abbildung 3.9: Korrekt ausgerichtetes rechtes Kiefergelenk. In diesem Fall liegt zufällig

auch das landmark OTL in derselben Schichtebene.
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3.2.2 2.Patientenfall; weiblich, 69 Jahre

linkes Kiefergelenk:

Abbildung 3.10: Linkes Kiefergelenk; Lage der landmarks in verschiedenen Ebenen

Abbildung 3.11: Normalenvektor, Rotationswinkel, Kontrollausgabe der landmark-

Koordinaten und Schichtdicke der Aufnahme
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Abbildung 3.12: Korrekt ausgerichtetes linkes Kiefergelenk

rechtes Kiefergelenk:

Abbildung 3.13: Rechtes Kiefergelenk; Lage der landmarks in verschiedenen Ebenen
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Abbildung 3.14: Normalenvektor, Rotationswinkel, Kontrollausgabe der landmark-

Koordinaten und Schichtdicke der Aufnahme

Abbildung 3.15: Korrekt ausgerichtetes rechtes Kiefergelenk
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3.2.3 3.Patientenfall; männlich, 51 Jahre

linkes Kiefergelenk:

Abbildung 3.16: Linkes Kiefergelenk; Lage der landmarks in verschiedenen Ebenen

Abbildung 3.17: Normalenvektor, Rotationswinkel, Kontrollausgabe der landmark-

Koordinaten und Schichtdicke der Aufnahme
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Abbildung 3.18: Korrekt ausgerichtetes linkes Kiefergelenk

rechtes Kiefergelenk:

Abbildung 3.19: Rechtes Kiefergelenk; Lage der landmarks in verschiedenen Ebenen
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Abbildung 3.20: Normalenvektor, Rotationswinkel, Kontrollausgabe der landmark-

Koordinaten und Schichtdicke der Aufnahme

Abbildung 3.21: Korrekt ausgerichtetes rechtes Kiefergelenk
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4 Diskussion

Zur Evaluierung so komplexer Strukturen wie dem Kiefergelenk ist eine

dreidimensionale Betrachtung unumgänglich. Die Prozessqualität einer solchen

Evaluierung kann durch die Untersuchung der Reproduzierbarkeit der

verwendeten landmarks sinnvoll beurteilt werden. Ein bewährtes Verfahren in

Studien zur Reproduzierbarkeit von landmarks in der Kephalometrie ist es, die

Euklidische Distanz zwischen zwei gleichen zu verschiedenen Zeitpunkten oder

von verschiedenen Untersuchern gesetzten landmarks zu messen, und daraus

einen Fehlerradius für jeden verwendeten landmark zu erstellen. Auf diesen

Fehlerradius haben verschiedene Faktoren Einfluss. Röntgentechnische und

projektorisch bedingte Fehler, wie zum Beispiel Verzerrung und Vergrößerung

oder die falsche Lagerung eines Patienten. Messfehler entstehen bei der

analytischen Auswertung der Bezugspunkte unter anderem durch Fehler in der

Nutzung der Hard- und Software [62]. Die wohl gravierendste Fehlerquelle stellt

der Identifikationsfehler dar. So können bei verschiedenen Untersuchern

unterschiedliche Vorstellungen in Bezug auf die Definition eines landmarks

bestehen [73]. Die Größe des durch fehlerhafte Interpretation der anatomischen

Strukturen entstehenden Fehlers ist in hohem Maße vom Übungsgrad und

radiologischen Wissen des Untersuchers abhängig [67, 46].

Um diese Fehlerquellen zu minimieren wurden die fünf Untersucher in dieser

Studie im Ungang mit der Auswertungssoftware ImageJ [58] geschult. Darüber

hinaus erfolgte eine Kalibrierung gegen einen Goldstandard bezüglich der

landmark Definitionen.

Die Art und Weise wie ein landmark erhoben werden kann hat entscheidenden

Einfluss auf seine Reproduzierbarkeit. So lassen sich grundsätzlich

verschiedene Typen von landmarks unterscheiden. Anatomische Punkte

werden durch anatomische Strukturen eindeutig bestimmt. Röntgenologische

Punkte sind durch die durch Überlagerungen anatomischer Strukturen

entstehenden Schnittpunkte definiert. Anthropologische Punkte sind

Extrempunkte von anatomischen Konturen. Ihre Lage ist nicht immer exakt
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definiert, da sie von der Lagerung und Neigung des Körpers abhängig sind.

Konstruierte Punkte werden erst durch geometrische Konstruktionen ermittelt.

Fuzzy landmarks haben eine größere Definition als ein einzelner Punkt und

variieren in der Subjektivität des Betrachters.

Wir haben die untersuchten landmarks nach ihrer Lage in drei Gruppen

aufgeteilt. Den geringsten durchschnittlichen Fehlerradius konnte die Gruppe

TMJ (

€ 

R TMJ = 1,89 mm ± 2,07 mm) aufweisen. Zu dieser Gruppe gehören die bei

unserer dreidimensionalen Determination des Kiefergelenks verwendeten

landmarks. Für die Gruppe Orbital (

€ 

R Orbital = 2,27 mm ± 1,87 mm) konnten die

zweit besten Ergebnisse erzielt werden. Die hier untersuchten landmarks

wurden aus den Studien von Waitzmann et al. [84, 85] übernommen, um die

von uns definierten landmarks mit schon in der Literatur etablierten landmarks

vergleichen zu können. Bei der Untersuchung der Gruppe Fuzzy (

€ 

R Fuzzy  = 2,38

mm ± 2,89 mm) trat bei dem Punkt FC_R (Fuzzy Condyle rechts) eine

Besonderheit auf. Entgegen der Erwartung, dass aufgrund der unscharfen

Definition ein großer Fehlerradius entsteht, weist dieser Punkt mit 

€ 

R FC_R  = 1,14

mm ± 1,24 mm den zweitkleinsten Fehlerradius aller untersuchten landmarks

auf. Offenbar greift in diesem Fall das Prinzip der Fuzzy logic, die davon

ausgeht, dass die Flexibilität der unscharfen Beschreibung zu besseren

Ergebnissen führt.

Wir haben in dieser Studie nicht die intraindividuelle sondern die

interindividuelle Reproduzierbarkeit der landmarks untersucht, um die

Prozessqualität unter realistischen Bedingungen beurteilen zu können. Durch

die Individualität der verschiedenen Untersucher sind die wechselnden

Bedingungen unter denen diese Arbeitsschritte durchgeführt werden realistisch

repräsentiert.

In Reliabilitätsstudien an zweidimensionalen Röntgenbildern liegen die

durchschnittlichen Fehlerradien sowohl bei intra- als auch bei interindividuellen

Vergleichen bei ca. 1 mm [5, 22, 47]. Bei Untersuchungen an

dreidimensionalen Röntgenbildern ist der Fehlerradius generell größer. So

fanden Abbott et al. einen durchschnittlichen intraindividuellen Fehlerradius von

etwa 1,7 mm und Kragskov et al. einen durchschnittlichen interindividuellen
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Fehlerradius von ca. 2 mm. In der vorliegenden Studie wurde für den

interindividuellen Fehlerradius für alle neunzehn untersuchten landmarks ein

Wert von durchschnittlich 

€ 

R LM  = 2,04 mm ± 2,20 mm gefunden. Die für die

Evaluation des Kiefergelenks definierten landmarks waren in der Gruppe TMJ

zusammengefasst und wiesen mit einem durchschnittlichen Fehlerradius von

€ 

R TMJ = 1,89 mm ± 2,07 mm eine überdurchschnittlich gute Reproduzierbarkeit

auf.

Abschließend lässt sich zusammenfassen, dass die von uns neu definierten

landmarks im Vergleich zu den bereits etablierten landmarks eine bessere

Reproduzierbarkeit zeigten. Die oben untersuchten landmarks TAA

(Tuberculum articulare anterior), SOS (Spina ossis sphenoidalis) und MAE

(Meatus acusticus externus) markieren die Grundebene des Gelenkspalts.

Diese landmarks ermöglichen eine reliable Definition der kaudalen Grenzebene

des Kiefergelenks zur volumetrischen Erfassung des Gelenksspaltes.

Die Reproduzierbarkeit dieser landmarks ermöglicht eine Ausrichtung des

Kiefergelenks bezüglich seiner Grundebene mit ausreichender Präzision.

Ursprünglich wurde die dreidimensionale Ausrichtung der CT-Aufnahmen

realisiert, indem die Aufnahmen aus einer horizontalen, einer sagittalen und

einer frontalen Ansicht betrachtet  wurden, jeweils die Winkel zwischen den

landmarks und der Horizontalen bzw. der Vertikalen gemessen und drei

entsprechende Rotationen um die x-, y- und z-Achse durchgeführt wurden. Ein

großer Nachteil bei dieser Methode ist, dass die Markierungen für die

Winkelmessungen nur näherungsweise nach Augenmaß gesetzt werden

können und somit eine beträchtliche Fehlerquelle in Kauf genommen werden

muss. Hiervon abgesehen ist das oben beschriebene manuelle Ausrichten der

Landmarks in eine Ebene sehr zeitintensiv. Konnten wir die benötigte Zeit pro

Gelenk letztendlich mit sehr viel Übung im Umgang mit Image Java auf

durchschnittlich etwa sieben Minuten verkürzen, so muss der Ungeübte doch

mindestens die doppelte bis dreifache Zeit investieren. Hieraus entstand die

Idee, die notwendigen Rotationswinkel und Rotationsrichtungen auf

mathematischem Wege zu bestimmen.
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Mit Hilfe der Koordinaten der drei landmarks lassen sich die Rotationswinkel

und Rotationsrichtungen mit absoluter Präzision errechnen. In dem von uns

programmierten Unterprogramm für die Auswertungssoftware ImageJ [58]

lassen sich die Winkel auf die Winkelsekunde exakt bestimmen.

Auch die Rotationen selbst werden in einem weiteren Arbeitsschritt von dem

Plugin durchgeführt. Hier findet sich eine weitere Fehlerquelle. Um das

Kiefergelenk von verschiedenen Seiten betrachten und um verschiedene

Achsen rotieren zu können, muss der Stack im Laufe des gesamten Ablaufs

dreimal umgerechnet werden. Das heißt, es werden drei „Reslices“

durchgeführt. Bei jedem Reslice verschlechtert sich durch Interpolation die

Auflösung der CT-Aufnahme. Aus diesem Grunde haben wir versucht, das

bereits existierende Plugin TransformJ Rotate zu nutzen. Hierbei müssen nur

die Rotationswinkel eingegeben werden und das Plugin führt die Rotationen

nacheinander um die x-, y- und z-Achse durch, ohne nach jeder Rotation eine

Messwertinterpolation durchzuführen. Allerdings wird nach der ersten Rotation

die Schichtdicke automatisch auf einen Millimeter festgelegt. Da dieser Wert

nicht mit der Schichtdicke der verwendeten CT-Aufnahmen übereinstimmt,

kommt es zu geometrischen Verzerrungen und damit zu unbrauchbaren

Ergebnissen. Trotz Kontaktaufnahme zu dem Autor des Plugins via E-Mail

konnte dieses Problem leider nicht gelöst werden. Aus diesem Grund wurde

das herkömmliche Verfahren mit den mehrfachen Reslices in Form eines

Makros in unser Plugin integriert. Auch bei diesem Verfahren ist es notwendig,

dass die Reslices mit den korrekten Schichtdicken angefertigt werden. Aus

diesem Grunde wurde eine Funktion integriert, die die Schichtdicke des

ursprünglichen Stacks auslesen kann.

Mit Hilfe des Plugins lassen sich deutlich präzisere Ergebnisse erzielen als mit

dem herkömmlichen Verfahren. Außerdem bedeutet es eine enorme

Zeitersparnis. Trotzdem sind noch einige Verbesserungen wünschenswert. So

sollte im Idealfall nur eine einzige Rotation und nicht wie bisher zwei Rotationen

durchgeführt werden. Hierzu müsste es allerdings möglich sein, für jedes CT

eine individuell errechnete Rotationsachse zu nutzen. Zur Optimierung der

Anwenderfreundlichkeit wäre es wünschenswert, wenn die Koordinaten schon
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beim Setzen der landmarks gespeichert und automatisch für die Rechnung

verwendet werden könnten. Somit könnte die zeitraubende manuelle Eingabe

der Koordinaten umgangen werden.
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5 Zusammenfassung

Die Simplifizierung der dreidimensionalen Struktur des Kiefergelenkes auf eine

zweidimensionale Projektion, wie in vielen bildgebenden Verfahren der Fall, ist

für dessen Beurteilung fragwürdig. Zur Evaluierung so komplexer Strukturen

wie dem Kiefergelenk ist eine dreidimensionale Betrachtung unumgänglich. Es

soll eine Methode entwickelt werden, mit der sich anhand von

computertomographischen Aufnahmen das Volumen des Gelenkspalts

bestimmen lässt. Hierzu wurden landmarks zur Grenzbestimmung des Gelenks

definiert. Zur Beurteilung der Prozessqualität wurden die landmarks auf ihre

interindividuelle Reproduzierbarkeit untersucht. Um eine Vergleichsmöglichkeit

zu haben, wurden neben den landmarks im Bereich der Kiefergelenke bereits in

der Literatur etablierte landmarks im Bereich der Orbita [84, 85] mit in die

Studie einbezogen. Außerdem wurden noch vier fuzzy-landmark untersucht.

Fünf Untersucher haben an identischen digitalen Kopien der ausgewählten

achtzehn originalen CT-Datensätze jeweils die neunzehn landmarks

identifiziert. Aus der Euklidischen Distanz zwischen zwei gleichen von den

verschiedenen Untersuchern gesetzten landmarks wurde ein Fehlerradius für

jeden untersuchten landmark erstellt.

Der interindividuelle Fehlerradius für alle neunzehn untersuchten landmarks lag

durchschnittlich bei 

€ 

R LM  = 2,04 mm ± 2,20 mm. Die für die Evaluation des

Kiefergelenks definierten landmarks wiesen mit einem durchschnittlichen

Fehlerradius von 

€ 

R TMJ = 1,89 mm ± 2,07 mm einen überdurchschnittlich guten

Wert auf. Im Vergleich mit den orbitalen landmarks mit einem Fehlerradius von

€ 

R Orbital = 2,27 mm ± 1,87 mm besitzen die landmarks im Bereich des

Kiefergelenks eine bessere Reproduzierbarkeit. Sie ermöglichen eine reliable

Definition der kaudalen Grenzebene des Kiefergelenks zur volumetrischen

Erfassung des Gelenksspaltes.

Für die graphische Ausrichtung der Kiefergelenke in Bezug auf diese

Grenzebene wurde für die verwendete Software ImageJ [58] ein Plugin

programmiert. Dieses Plugin errechnet mit Hilfe der Koordinaten der
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entsprechenden landmarks die Rotationswinkel und Rotationsrichtung und führt

die entsprechenden Rotationen aus. Auf diese Weise werden die Kiefergelenke

mit großer Präzision entsprechend ihrer Grenzebene im dreidimensionalen

Raum ausgerichtet. Die vorliegende Arbeit beinhaltet eine ausführliche

Bedienungsanleitung für die Nutzung von ImageJ und dem beschriebenen

Plugin.



Literaturverzeichnis

100

6 Literaturverzeichnis

1. Abbott AH, Netherway DJ, David DJ, Brown T. Craniofacial Osseus

Landmark Determination from Stereo Computer Tomography

Reconstructions. Ann Acad Med Singapore 1990;19:595-604.

2. Ahlers MO, Jakstat HA. Klinische Funktionsanalyse. 2. Aufl. Hamburg:

dentaConcept, 2000.

3. Alder ME, Deahl ST, Matteson SR. Clinical Usefulness of Two-

Dimensional Reformatted and Three-Dimensionally Rendered

Computerized Tomographic Images: Literature Review and a Survey of

Surgeons´ Opinions. J Oral Maxillofac Surg 1995;53:375-86.

4. Athanasiou AE, Miethke RR, van der Meij AJW. Random Errors in

Localization of landmarks in postero-anterior Cephalograms. Br J Orthod

1999;26:273-84.

5. Baumrind S, Frantz RC. The reliability of head film measurements – 1.

Landmark identification. Am J Orthod. 1971;60:111-27.

6. Benninghoff, Drenckhahn D. Anatomie- Makroskopische Anatomie,

Histologie, Embryologie, Zellbiologie. Band 1. 16. Aufl. München-Jena:

Urban und Fischer Verlag, 2003.

7. Bookstein FL, Grayson B, Cutting CB, McCarthy JG. Landmarks in three

dimensions: Reconstruction from cephalograms versus direct

observation. Am J Orthod and Dentofacial Orthop 1991;100:133-40.

8. Boucher LJ, Jacoby J. Posterior Border movements of human mandible.

J Prosthet Dent, 1968;20:106-12.

9. Brooks SL, Brand JW, Gibbs SJ, Hollender L, Lurie AG, Omnell KA.

Imaging of the temporomandibular joint: A position paper of the Amercian

Academy of Oral and Maxillofacial Radiology. Oral Surg Oral Med Oral

Pathol Oral Radiol Endod 1997;83:609-18.



Literaturverzeichnis

101

10. Brown T, Abbott AH. Computer-assisted location of reference points in

three dimensions for radiographic cephalometry. Am J Orthod and

Dentofacial Orthop 1989;95:490-8.

11. Bumann A, Lotzmann U. Farbatlanten der Zahnmedizin – Band 12:

Funktionsdiagnostik und Therapieprinzipien. 1. Aufl. Stuttgart-New York:

Georg Thieme Verlag, 1999.

12. Calagna LJ, Silverman SI, Garfinkel L. Influence of neuromuscular

conditioning on centric relation registrations. J Prosthet Dent

1973;30:598-604.

13. Cavalcanti MGP, Haller JW, Vannier MW. Three-Dimensional Computed

Tomography Landmark Measurement in craniofacial surgical planning:

Experimental Validation in vitro. J Oral Maxillofac Surg 1999;57:690-4.

14. Cavalcanti MGP, Rocha SS, Vannier MW. Craniofacial measurements

based on 3D-CT volume rendering: Implications for clinical applications.

Dentomaxillofac Radiol. 2004;33:170-6.

15. Cavalcanti MGP, Vannier MW. Quantitative analysis of spiral computed

tomography for craniofacial clinical applications. Dentomaxillofac Radiol

1998;27:344-50.

16. Christiansen EL, Chan TT, Thompson JR, Hasso AN, Hinshaw DB.

Computed tomography of the normal temporomandibular joint. Scand J

Dent Res 1987;95:499-509.

17. Christiansen EL, Thompson JR, Hasso AN. CT Evaluation of Trauma to

the Temporomandibular Joint. J Oral Maxillofac Surg 1987;45:920-3.

18. Christiansen EL, Thompson JR, Kopp S. Intra- and inter-observer

variability and accuracy in the determination of linear and angular

measurements in computed tomography. An in vitro and in situ study of

human mandibles. Acta odontol Scand 1986;44:221-9.



Literaturverzeichnis

102

19. Christiansen EL, Thompson JR, Zimmermann G, Roberts D, Hasso AN,

Hinshaw DB, Kopp S, Linda L. Computed tomography of condylar and

articular disk positions within the temporomandibular joint. Oral Surg Oral

Med Oral Pathol1987;64:757-67.

20. Cole III TM, Richtsmeier JT. A Simple Method for Visualization of

Influential Landmarks when using Euclidean Distance Matrix Analysis.

Am J Phys Anthropol 1998;107:273-83.

21. de Bont LGM, van der Kuijl B, Stegenga B, Vencken LM, Boering G.

Computed tomography in differential diagnosis of temporomandibular

joint disorders. Int J Oral Maxillofac Surg 1993;22:200-9.

22. El-Mangoury NH, Shaheen SI, Mostafa YA. Landmark identification in

computerized posteroanterior cephalometrics. Am J Orthod Dentofacial

Orthop 1987;91:57-61.

23. Enciso R, Shaw A, Neumann U, Mah J. 3D head anthropometric

analysis. SPIE Medical Imaging, San Diego, Ca, Feb. 2003, Computer

Graphics and Immersive Technologies.

24. Fanghänel J, Pera F, Anderhuber F, Nitsch R. Waldeyer- Anatomie des

Menschen. 17. Aufl. Berlin-New York: Walter de Gruyter Verlag, 2003.

25. Fuchs WA, Becker C, Krestin GP. Radiologie – Diagnostik durch

bildgebende Verfahren. Bern-Göttingen-Toronto-Seattle: Hans Huber

Verlag, 1996.

26. Glossary of Prosthodontic terms. J Prosthet Dent 1956;6:7-34.

27. Glossary of Prosthodontic terms. J Prosthet Dent 1987;58:713-62.

28. Glossary of Prosthodontic terms. J Prosthet Dent 1994;71:41-112.

29. Harvati K. Quantitative Analysis of Neanderthal Temporal Bone

Morphology using three-dimensional geometric Morphometrics. Am J

Phys Anthropol 2003;120:323-38.



Literaturverzeichnis

103

30. Helkimo M, Ingervall B, Carlsson GE. Variation of retruded and muscular

position of mandible under different recording conditions. Acta Odontol

Scand 1971;29:423-37.

31. Hennessy RJ, Stringer CB. Geometric Morphometric Study of the

Regional Variation of Modern Human Craniofacial Form. Am J Phys

Anthropol 2002;117:37-48.

32. Honda K, Larheim TA, Johannessen S, Arai Y, Shinoda K, Westesson

PL. Ortho cubic super-high resolution computed tomography – A new

radiographic technique with application to the temporomandibular joint.

Oral Surg Oral Med Oral Pathol Oral Radiol Endod 2001;91:239-43.

33. Huisinga-Fischer CE, Zonneveld FW, Vaandrager JM, Prahl-Andersen B.

CT-Based Size and Shape Determination of the Craniofacial Skeleton: A

New Scoring System to Assess Bony Deformities in Hemifacial

Microsomia. J Craniofac Surg 2001;12:87-94.

34. Huisinga-Fischer CE, Zonneveld FW, Vaandrager JM, Prahl-Andersen B.

Relationship in Hypoplasia between the Masticatory Muscels and the

Craniofacial Skeleton in Hemifacial Microsomia, as Determined by 3-D

CT Imaging. J Craniofac Surg 2001;12:31-40.

35. Kane AA, Lo LJ, Christensen GE, Vannier MW, Marsh JL. Relationship

between Bone and Muscels of Mastication in Hemifacial Microsomia.

Plast Reconstr Surg 1997;99:990-7.

36. Kane AA, Lo LJ, Vannier MW, Marsh JL. Mandibular Dysmorphology in

Unicoronal Synostosis and Plagiocephaly without Synostosis. Cleft

Palate Craniofac J. 1996;33:418-23.

37. Kragskov J, Bosch C, Gyldensted C, Sindet-Pedersen S. Comparison of

the Reliability of Craniofacial Anatomic Landmarks based on

Cephalometric Radiographs and Three-Dimensional CT Scans. Cleft

Palate Craniofac J 1997;3:111-6.



Literaturverzeichnis

104

38. Kusnoto B, Evans CA, BeGole EA, de Rijk W. Assessment of 3-

dimensional computer-generated cephalometric measurements. Am J

Orthod Dentofacial Orthop 1999;116:390-9.

39. Lele S, Richtmeier JT. Euclidean Distance Matrix Analysis: Confidence

intervals for form and growth differences. Am J Phys Anthropol

1995;98:73-86.

40. Lele S, Richtsmeier JT. Euclidean Distance Matrix Analysis: A

coordinate-free approach for comparing biological shapes using

landmark data. Am J Phys Anthropol 1991;86:415-27.

41. Lele S, Richtsmeier JT. On comparing biological shapes: Detection of

influential landmarks. Am J Phys Anthropol 1992;87:49-65.

42. Lockwood CA, Lynch JM, Kimbel WH. Quantifying temporal bone

morphology of great apes and humans: An approach using geometric

morphometrics. J Anat 2002;201:447-64.

43. Major PW, Johnson DE, Hesse KL, Glover KE. Landmark identification

error in posterior anterior cephalometrics. Angle Orthod 1994;64:447-54.

44. Marmulla R, Brief J, Heurich T, Mühling J, Hassfeld S. Perspektiven in

der rechnergestützten Implantologie. Z Zahnärztl Implantol 2002;18:152-

8.

45. Marsh JL, Dan Baca BA, Vannier MW. Facial Musculoskeletal

Asymmetry in Hemifacial Microsomia. Cleft Palate Craniofac J

1989;26:292-302.

46. McWilliam JS, Welander U. The Effect of Image Quality on the

Identification of Cephalometric Landmarks. Angle Orthod 1978;48:49-56.

47. Midtgard J, Björk G, Linder-Aronson S. Reproducibility of Cephalometric

Landmarks and Errors of Measurements of Cephalometric Cranial

Distances. Angle Orthod 1974;44:56-61.

48. Novelline RA, Heuck A. Squire´s Radiologie. 5. Aufl. Stuttgart-New York:

Schattauer Verlagsgesellschaft, 2001.



Literaturverzeichnis

105

49. Offutt CJ, Vannier MW, Gilula LA, Marsh JL, Sutherland CJ. Volumetric

3-D imaging of computerized tomography scans. Radiol Technol

1990;61:212-9.

50. Ong TK, Franklin A. A clinical and histopathological study of

osteoarthrosis of the temporomandibular joint. Br J Oral Maxillofac Surg

1996;34:186-92

51. Ono I, Ohura T, Narumi E, Kawashima K, Matsuno I, Nakamura S,

Ohhata N, Uchiyama Y, Watanabe Y, Fumiki T, Kishinami T. Three-

dimensional analysis of craniofacial bones using three-dimensional

computer tomography. J Craniomaxillofac Surg 1992;20:49-60.

52. Pasler FA. Zahnärztliche Radiologie. 4. Aufl. Stuttgart-New York: Thieme

Verlag, 2003.

53. Petrilli A, Gurley JF. Tomography of the temporomandibular joint. J Am

dent Assoc 1939;26:304-9

54. Philips Medical Systems Nederland. DICOM Cook Book for

I m p l e m e n t a t i o n s  i n  M o d a l i t i e s .

ftp://ftp-wjq.philips.com/medical/interoperability/out/DICOM_Information/

CookBook.pdf; Version 1.1, Jan. 1997.

55. Piehslinger E, Celar A, Celar R, Jäger W, Slavicek R . Reproducibility of

the Condylar Reference Position. J Orofac Pain 1993;7:68-75.

56. Posselt U. Studies in the Mobility of the Human Mandible. Acta Odontol

Scand 1952;10:8-153.

57. Putz R, Pabst R. Sobotta- Atlas der Anatomie des Menschen. Band 1.

20. Aufl. München-Wien-Baltimore: Urban und Schwarzenberg Verlag,

1993.

58. Rasband W. Image Java. National Institutes of Health, Bethesda, MD.

http://rsb.info.nih.gov/ij.

59. Raustia AM, Pyhtinen J. Morphology of the condyles and mandibular

fossa as seen by computed tomography. J Prosthet Dent 1990;63:77-85.



Literaturverzeichnis

106

60. Richtsmeier JT, Lele S. A coordinate-free approach to the analysis of

growth patterns: Models and theoretical considerations. Biol Rev Camb

Philos Soc 1993;68:381-411.

61. Richtsmeier JT, Lele S. Analysis of craniofacial Growth in Crouzon

Syndrome Using Landmark Data. J Craniofac Genet Deve Biol

1990;10:39-62.

62. Richtsmeier JT, Paik CH, Elfert PC, Cole III TM, Dahlmann HR.

Precision, Repeatability and Validation of the Localization of Cranial

Landmarks Using Computed Tomography Scans. Cleft Palate Craniofac

J 1995;32:217-27.

63. Roberts D, Pettigrew J, Udupa J, Ram C. Three-dimensional imaging

and display of the temporomandibular joint. Oral Surg Oral Med Oral

Pathol Oral Radiol Endod 1984;58:461-74.

64. Rosenbusch G, Oudkerk M, Ammann E. Radiologie in der medizinischen

Diagnostik. Berlin: Blackwell Wissenschafts-Verlag, 1994.

65. Roth DA, Gosain AK, McCarthy JG, Stracher MA, Lefton DR, Grayson

BH. A CT Scan Technique for Quantitative Volumetric Assessment of the

Mandible after Distraction Osteogenesis. Plast Reconstr Surg

1997;99:1237-47.

66. Schiebler TH, Schmidt W, Zilles K. Anatomie. 8. Aufl. Berlin-Heidelberg-

New York: Springer Verlag, 1999.

67. Schmuth G, Drescher D. Kieferorthopädie I. 3. Aufl., Urban und

Schwarzenberg Verlag, München-Wien-Baltimore, 1994.

68. Schüller A. Die Schädelbasis im Röntgenbilde. Hamburg: Gräfe + Sillem,

1905.

69. Schwenzer N, Ehrenfeld M. Zahn- Mund- Kieferheilkunde Band 1

Allgemeine Chirurgie. 3. Aufl. Stuttgart-New York: Georg Thieme Verlag,

2000.



Literaturverzeichnis

107

70. Sherwood RJ, Rowley RB, Ward SC. Relative placement of the

mandibular fossa in great apes and humans. J Hum Evol 2002;43:57-66.

71. Sherwood RJ, Ward SC, Hill A. The taxonomic status of the Chemeron

temporal (KNM-BC 1). J Hum Evol 2002;42:153-84.

72. Siegler S, Hayes R, Nicolella D, Fielding A. A technique to investigate

the three-dimensional kinesiology of the human temporomandibular joint.

J Prosthet Dent 1991;65:833-9.

73. Stabrun AE, Danielsen K. Precision in cephalometric landmark

identification. Eur J Orthod 1982;4:185-96.

74. Thompson JR, Christiansen E, Hasso AN, Hinshaw DB.

Temporomandibular Joints: High-Resolution Computed Tomographic

Evaluation. Radiology 1984;150:105-10.

75. Thurn P, Bücheler E, Lackner KJ, Thelen M. Einführung in die

radiologische Diagnostik. 10. Aufl. Stuttgart-New York: Thieme Verlag,

1998.

76. Tobias, PV. Re-Creating Ancient Hominid Virtual Endocasts by CT-

Scanning. Clin Anat 2001;14:134-41.

77. Togashi K, Kitaura H, Yonetsu K, Yoshida N, Nakamura T. Three-

Dimensional Cephalometry Using Helical Computer Tomography:

Measurement Error Caused by Head Inclination. Angle Orthod

2002;72:513-20.

78. Valeri CJ, Cole TM, Lele S, Richtsmeier JT. Capturing Data from Three-

Dimensional Surfaces Using Fuzzy Landmarks. Am J Phys Anthropol

1998;107:113-24.

79. van der Kuijl B, Vencken LM, de Bont LGM, Boering G.

Temporomandibular joint computed tomography: Development of a direct

sagittal technique. J Prosthet Dent 1990;64:709-15.



Literaturverzeichnis

108

80. van der Kuijl, de Bont LGM, Stegenga B, Boering G. Histologic

Evaluation of Computed Tomographic TMJ Articular Disk Visualization.

Cranio, 1994;12:100-9.

81. Vannier MW. Craniofacial computed tomography scanning: Technology,

applications and future trends. Orthod Craniofac Res 2003;6:23-30.

82. von Török A. Über die Stellung der Längsachsen der Gelenkköpfe beim

menschlichen Unterkiefer. Zeitschrift für Morphologie und Anthropologie

1899;1:379-450.

83. Wagner D, Ott M, Pittenauer M. SubEthaEdit® 2.0.1 (v751).

84. Waitzmann AA, Posnick JC, Armstrong DC, Pron GE. Craniofacial

Skeletal Measurements Based on Computed Tomography: Part I.

Accuracy and Reproducibility. Cleft Palate Craniofac J 1992;29:112-7.

85. Waitzmann AA, Posnick JC, Armstrong DC, Pron GE:. Craniofacial

Skeletal Measurements Based on Computed Tomography: Part II.

Normal Values and Growth Trends. Cleft Palate Craniofac J

1992;29:118-28.

86. Williams F, Richtsmeier JT. Comparison of Mandibular Landmarks from

Computed Tomography and 3D Digitizer Data. Clin Anat 2003;16:494-

500.

87. Yune HY. Two-dimensional – three-dimensional reconstruction computed

tomography techniques. Dent Clin North Am 1993;37:613-26.

88. Zumpano MP, Carson BS, Marsh JL, Vanderkolk CA, Richtsmeier JT.

Three-Dimensional Morphological Analysis of Isolated Metopic

Synostosis. Anat Rec 1999;256:177-88.



Abbildungsverzeichnis

109

7 Abbildungsverzeichnis

Abbildung 1.1: Schnittbild Kiefergelenk von lateral (aus [57]) ............................... 2

Abbildung 1.2: Schnittbild Kiefergelenk von lateral bei Mundöffnung (aus [57]).... 3

Abbildung 1.3: Wilhelm Conrad Röntgen und die am 22.12.1895 angefertigte

Aufnahme von der Hand seiner Frau............................................ 8

Abbildung 1.4: Computertomograph der Firma Siemens .................................... 13

Abbildung 1.5: Menschlicher Schädel, Leonardo da Vinci, um 1500. ................. 21

Abbildung 2.1: Meatus acusticus externus (MAE)............................................... 35

Abbildung 2.2: Spina ossis sphenoidalis (SOS) .................................................. 36

Abbildung 2.3: Tuberculum articulare anterior (TAA) .......................................... 37

Abbildung 2.4: Os temporale laterale (OTL)........................................................ 38

Abbildung 2.5: Fuzzy condyle (FC) ..................................................................... 38

Abbildung 2.6: Fuzzy lambda (FL) ...................................................................... 39

Abbildung 2.7: Fuzzy sella (FS) .......................................................................... 39

Abbildung 2.8: Laterale Orbita (LO), Os temporale mediale (OTM), Mediale Orbita

(MO)............................................................................................ 40

Abbildung 2.9: Foramen incisivum (FI) ............................................................... 41

Abbildung 2.10: Landmarks zur Bestimmung der Gelenkspaltgrenzen............... 46

Abbildung 2.11: Grundebene des Gelenkspaltvolumens .................................... 47

Abbildung 2.12: ImageJ: Properties .................................................................... 48

Abbildung 2.13: ImageJ: Rectangular Tool zur Auswahl des interessierenden

Bereichs...................................................................................... 49

Abbildung 2.14: Lage der vier Kiefergelenk-landmarks in verschiedenen

Schichtebenen. ........................................................................... 50



Abbildungsverzeichnis

110

Abbildung 2.15: ImageJ: Angle Tool zur Messung des Winkels für die Rotation

um die z-Achse. .......................................................................... 51

Abbildung 2.16: ImageJ: Reslice......................................................................... 52

Abbildung 2.17: Ansicht des linken Kiefergelenks von lateral. ............................ 52

Abbildung 2.18: ImageJ: Angle Tool zur Messung des Winkels für die Rotation

um die x-Achse. .......................................................................... 53

Abbildung 2.19: ImageJ: Reslice......................................................................... 54

Abbildung 2.20: Ansicht des linken Kiefergelenks von anterior........................... 55

Abbildung 2.21: ImageJ: Angle Tool zur Messung des Winkels für die Rotation

um die y-Achse. .......................................................................... 55

Abbildung 2.22: Alle drei landmarks sind in die gleiche Schichtebene rotiert...... 57

Abbildung 2.23: Zwischen drei Punkten im dreidimensionalen Raum wird eine

Ebene aufgespannt..................................................................... 59

Abbildung 2.24: Der Normalenvektor steht senkrecht auf der Ebene. Zu jeder

Ebene gibt es zwei Normalenvektoren........................................ 60

Abbildung 2.25: Zahlenbeispiele zur Berechnung von Winkeln zwischen zwei

Vektoren ..................................................................................... 62

Abbildung 2.26: Unterteilung eines Koordinatensystems in Oktanten................. 66

Abbildung 2.27: ImageJ: Properties .................................................................... 72

Abbildung 2.28: ImageJ: Rectangular Tool zur Auswahl des interessierenden

Bereichs...................................................................................... 73

Abbildung 2.29: Lage der vier Kiefergelenk-landmarks in verschiedenen

Schichtebenen. ........................................................................... 73

Abbildung 2.30: ImageJ: Koordinaten der gesetzten landmarks. ........................ 74

Abbildung 2.31: ImageJ: Eingabeaufforderung des Plugin ................................. 75

Abbildung 2.32: ImageJ: Ergebnisfenster des Plugin.......................................... 75

Abbildung 2.33: Substack Maker: Überflüssige Schichten werden gelöscht ....... 76



Abbildungsverzeichnis

111

Abbildung 2.34: Das korrekt ausgerichtete linke Kiefergelenk. ........................... 76

Abbildung 3.1: Interindividuelle Fehlerradien aller untersuchten landmarks. ...... 79

Abbildung 3.2: Gegenüberstellung der verschiedenen landmark-Gruppen......... 81

Abbildung 3.3: Gruppe Orbital und Gruppe Fuzzy .............................................. 81

Abbildung 3.4: Linkes Kiefergelenk; Lage der landmarks in verschiedenen

Ebenen ....................................................................................... 83

Abbildung 3.5: Normalenvektor, Rotationswinkel, Kontrollausgabe der landmark-

Koordinaten und Schichtdicke der Aufnahme............................. 84

Abbildung 3.6: Korrekt ausgerichtetes linkes Kiefergelenk. In diesem Fall liegt

zufällig auch das landmark OTL in derselben Schichtebene. ..... 84

Abbildung 3.7: Rechtes Kiefergelenk; Lage der landmarks in verschiedenen

Ebenen ....................................................................................... 85

Abbildung 3.8: Normalenvektor, Rotationswinkel, Kontrollausgabe der landmark-

Koordinaten und Schichtdicke der Aufnahme............................. 85

Abbildung 3.9: Korrekt ausgerichtetes rechtes Kiefergelenk. In diesem Fall liegt

zufällig auch das landmark OTL in derselben Schichtebene. ..... 86

Abbildung 3.10: Linkes Kiefergelenk; Lage der landmarks in verschiedenen

Ebenen ....................................................................................... 87

Abbildung 3.11: Normalenvektor, Rotationswinkel, Kontrollausgabe der landmark-

Koordinaten und Schichtdicke der Aufnahme............................. 87

Abbildung 3.12: Korrekt ausgerichtetes linkes Kiefergelenk ............................... 88

Abbildung 3.13: Rechtes Kiefergelenk; Lage der landmarks in verschiedenen

Ebenen ....................................................................................... 88

Abbildung 3.14: Normalenvektor, Rotationswinkel, Kontrollausgabe der landmark-

Koordinaten und Schichtdicke der Aufnahme............................. 89

Abbildung 3.15: Korrekt ausgerichtetes rechtes Kiefergelenk............................. 89

Abbildung 3.16: Linkes Kiefergelenk; Lage der landmarks in verschiedenen

Ebenen ....................................................................................... 90



Abbildungsverzeichnis

112

Abbildung 3.17: Normalenvektor, Rotationswinkel, Kontrollausgabe der landmark-

Koordinaten und Schichtdicke der Aufnahme............................. 90

Abbildung 3.18: Korrekt ausgerichtetes linkes Kiefergelenk ............................... 91

Abbildung 3.19: Rechtes Kiefergelenk; Lage der landmarks in verschiedenen

Ebenen ....................................................................................... 91

Abbildung 3.20: Normalenvektor, Rotationswinkel, Kontrollausgabe der landmark-

Koordinaten und Schichtdicke der Aufnahme............................. 92

Abbildung 3.21: Korrekt ausgerichtetes rechtes Kiefergelenk............................. 92



Tabellenverzeichnis

113

8 Tabellenverzeichnis

Tabelle 2.1: Überblick über die untersuchten landmarks .................................... 34

Tabelle 2.2: Richtungsbestimmung des Normalenvektors. ................................. 66

Tabelle 2.3: Rotationswinkel und Rotationsrichtung. .......................................... 70

Tabelle 3.1: Ergebnisse aller untersuchten landmarks ....................................... 78



Anhang

I

9 Anhang

9.1 Sourcecode des Plugins „TMJ_Rotation“

Im Folgenden ist der Wortlaut des mit SubEthaEdit® [83] programmierten Plugin

aufgeführt:

import ij.*;

import ij.process.*;

import ij.plugin.*;

import ij.plugin.filter.Analyzer;

import ij.measure.*;

import ij.gui.*;

import java.awt.*;

/** This example creates a GenericDialog containing a 5x5 grid of numeric

fields. */

public class TMJ_Rotation implements PlugIn {

// Variablen für die Winkelberechnung

    double a, b, c, d, e, f, g, h, j;

    public String alpha = " ";

    public String beta = " ";

    int gridWidth = 3;

    int gridHeight = 3;

    int gridSize = gridWidth*gridHeight;

    TextField[] tf = new TextField[gridSize];

    double[] value = new double[gridSize];
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    public void run(String arg) {

        if (IJ.versionLessThan("1.31l"))

            return;

        if (showDialog())

            displayValues();

    }

// Bestimmung der Schichtdicke

    ImagePlus imp = WindowManager.getCurrentImage();

    Calibration cal = imp.getCalibration();

    double res = cal.pixelWidth;

    double depth = cal.pixelDepth; // Schichtdicke in Unit

// Eingabe-Pop-Up

    boolean showDialog() {

        GenericDialog gd = new GenericDialog("Rotationswinkel");

        gd.addMessage(" ");

        gd.addMessage("Eingabe der Koordinaten der Landmarks");

        gd.addMessage("nach folgendem Schema:");

        gd.addMessage("MAE (a | b | c)");

        gd.addMessage("SOS (d | e | f)");

        gd.addMessage("TAA (g | h | i)");

        gd.addMessage(" ");

        gd.addMessage("Eingabe mit Punkt statt Komma!");

        gd.addMessage(" ");
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        gd.addPanel(makePanel(gd));

        gd.showDialog();

        if (gd.wasCanceled())

            return false;

        getValues();

        return true;

    }

    Panel makePanel(GenericDialog gd) {

        Panel panel = new Panel();

            panel.setLayout(new GridLayout(gridWidth, gridHeight));

        for (int i=0; i<gridSize; i++) {

            tf[i] = new TextField(" "+value[i]+" ");

            panel.add(tf[i]);

        }

        return panel;

    }

    void getValues() {

        for (int i=0; i<gridSize; i++) {

            String s = tf[i].getText();

            value[i] = getValue(s);

        }

        a = value[0];

        b = value[1];

        c = value[2];

        d = value[3];

        e = value[4];

        f = value[5];

        g = value[6];
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        h = value[7];

        j = value[8];

// Berechnung des Normalenvektors

        double nvec_x = e*j-c*e-b*j-f*h+c*h+b*f;

        double nvec_y = f*g-c*g-a*f-d*j+a*j+c*d;

        double nvec_z = d*h-b*d-a*h-e*g+a*e+b*g;

// Nur Normalvektoren mit positivem z-Wert

        if (nvec_z < 0) {

            nvec_x = nvec_x*(-1);

            nvec_y = nvec_y*(-1);

            nvec_z = nvec_z*(-1);

        }

// Berechnung der Rotationswinkel

        double cos_a =

(nvec_z)/Math.sqrt(Math.pow((nvec_y),2)+Math.pow((nvec_z),2));

        double cos_b =

(nvec_x)/Math.sqrt(Math.pow((nvec_x),2)+Math.pow((nvec_y),2)+Math.pow((nv

ec_z),2));

        double acos_a = Math.acos(cos_a);

// Rotationsrichtung der ersten Rotation

        if (nvec_y <0)

            acos_a=acos_a*(-1);

        double acos_b = Math.acos(cos_b);
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//Kontrollfenster: Rotationswinkel

        IJ.log("Normvector (x/y/z): "+IJ.d2s(nvec_x)+" / "+IJ.d2s(nvec_y)+" /

"+IJ.d2s(nvec_z));

        IJ.log("alpha = "+IJ.d2s(Math.toDegrees(acos_a))+"° (Rotation um die x-

Achse)");

        IJ.log("beta  = "+IJ.d2s((90-(Math.toDegrees(acos_b)))*(-1))+"° (Rotation

um die y-Achse)");

// Berechnung Gradzahl von alpha und beta

        alpha = IJ.d2s(Math.toDegrees(acos_a));

        beta = IJ.d2s((90-(Math.toDegrees(acos_b)))*(-1));

// Rotationen

IJ.run("Substack Maker");

IJ.run("Select All");

IJ.run("Reslice [/]...", "input="+depth+" output=0.5 start=Left  ");

IJ.run("Arbitrarily...", "stack angle="+alpha+" interpolate");

IJ.run("Reslice [/]...", "input=0.500 output=0.500 start=Left  ");

IJ.run("Arbitrarily...", "stack angle="+beta+" interpolate");

IJ.run("Reslice [/]...", "input=0.500 output=0.500 start=Left  ");

    }

// Kontrollfenster: Input und Slice-Thickness

    void displayValues() {

        IJ.log("\nKontrollausgabe:");

        for (int i=0; i<gridSize; i++)

            IJ.log(i+"  "+value[i]);

        IJ.log("SliceThickness: "+depth);
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    }

    double getValue(String theText) {

        Double d;

        try {d = new Double(theText);}

        catch (NumberFormatException e){

            d = null;

        }

        return d==null?Double.NaN:d.doubleValue();

    }

}
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